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 Important Information

Warranty
The NI VXIpc-882 controller is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective 
during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in 
materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments 
will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects 
during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any 
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by 
warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In 
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document 
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National 
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING 
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of 
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against 
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service 
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the 
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside 
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, 
partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products/technology, refer to the appropriate location: Help»Patents in your software, 
the patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE 
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, 
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR 
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF 
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY 
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, 
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, 
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS 
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION 
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY 
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER 
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT 
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

Compliance with FCC/Canada Radio Frequency Interference 
Regulations

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.
Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.
All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.
Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 
Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the 
FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance with EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the 
CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance 
information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.
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About This Manual

This manual contains detailed instructions for installing and 
configuring your National Instruments VXIpc-882 embedded computer 
kit.

How to Use the Documentation Set
Begin by reading NI VXIpc-882 Installation Guide, a brief quick-start guide 
that describes how to install and get started with your controller.

This manual, the NI VXIpc-882 User Manual, contains more details about 
changing the installation or configuration from the defaults and using the 
hardware.

Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.
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monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. This font also emphasizes lines of code 
that are different from the other examples.

Related Documentation
The following documents contain information you may find helpful as you 
read this manual:

• ANSI/IEEE Standard 1014-1987, IEEE Standard for a Versatile 
Backplane Bus: VMEbus

• ANSI/IEEE Standard 1155-1998, IEEE VMEbus Extensions for 
Instrumentation: VXIbus

• ANSI/VITA 1-1994, VME64

• VXI-6, VXIbus Mainframe Extender Specification, Rev. 2.0, 
VXIbus Consortium

• VXI-8, Cooling Characterization Methodology Specification, 
Rev. 2.0, VXIbus Consortium

• NI-VISA Help
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1
Introduction

NI VXIpc-882 Overview

Description
The NI VXIpc-882 embedded computer is a C-size VXIbus system 
controller. The controller uses off-the-shelf Intel PC technology to bring 
you powerful VXI system control in a familiar PC environment. Using 
state-of-the-art packaging, the NI VXIpc-882 provides powerful control in 
a two-slot configuration.

Install a NI VXIpc-882 controller in your VXI mainframe, and you can take 
full advantage of the high-performance VXI backplane and have direct 
control of VXI registers, memory, interrupts, and triggers. 

The NI VXIpc-882 computers are fully VXIplug&play compliant and 
compatible with PC-compatible software tools, the National Instruments 
LabVIEW and LabWindows™/CVI™ application software, and the 
NI-VISA, NI-VXI, and NI-488.2 bus interface software.

Modules
The NI VXIpc-882 controller has a standard I/O set that includes integrated 
DVI-I video, four Hi-Speed USB ports, one RS-232 serial port, one parallel 
port, a 10/100/1000 Ethernet port, GPIB, an ExpressCard/34 slot, SMB 
connectors for trigger and clock I/O, and a system reset button. The 
NI VXIpc-882 features an Intel® Core™ 2 Duo processor T7400 (2.16 GHz 
dual core processor) and an 80 GB (or larger) hard drive.
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NI VXIpc-882 Functional Block Diagram
Figure 1-1 is a functional block diagram of the NI VXIpc-882 controller.

Figure 1-1.  NI VXIpc-882 Block Diagram

NI VXIpc-882 Functional Description
This section contains brief functional descriptions of the major 
NI VXIpc-882 logic blocks shown in Figure 1-1.

• The SO-DIMM block consists of two DDR2 SDRAM sockets that can 
hold up to 2 GB each.

• The Gigabit Ethernet connects to either 10 Mbit, 100 Mbit, or 
1,000 Mbit Ethernet interfaces.

• The Watchdog Timer block consists of a watchdog timer that can reset 
the controller.

Intel Core 2
Duo CPU

Graphics
Memory

Controller
Hub

DVI-I
Connector

Gigabit
Ethernet

I/O
Controller

Hub

LPT

  COM 1 

Watchdog

Super I/O

LPC Bus

DMI

Chip Set

Chip Set

VXI
Interface

External
Clock SMB

VXI Trigger 
IN SMB

VXI Trigger 
OUT SMB

GPIBPCI Bus

DUAL CH

Hard Drive

Flash ROM

ExpressCard/34
Slot

4 Hi-Speed
USB Ports

2 SO-DIMMs
DDR2 SDRAM

PC2 5300

Trigger
Card



Chapter 1 Introduction

© National Instruments Corporation 1-3 NI VXIpc-882 User Manual

• The Super I/O block represents the other peripherals included with the 
NI VXIpc-882 controller, including:

– One serial port

– One parallel port

• The GPIB block contains the GPIB interface.

• The ExpressCard/34 slot accommodates an ExpressCard/34 module.

• The VXI Interface connects the NI VXIpc-882 controller to the VXI 
backplane through the National Instruments MITE ASIC.

• The External Clock SMB provides an input for an external source to 
generate CLK10 to the VXI backplane or allow you to output CLK10 
to an external device.

• The VXI Trigger In/Out SMBs provide a routable connection of the 
VXI triggers to and from the VXI backplane.

National Instruments Software
National Instruments has developed several software kits you can use with 
the NI VXIpc-882. NI-VISA and NI-VXI are already installed on your hard 
drive; LabVIEW is optional.

NI-VISA is the National Instruments implementation of the VISA 
specification. VISA is a uniform API for communicating and controlling 
Serial, GPIB, VXI, and VME instruments. This API aids in the creation of 
more portable applications and instrument drivers.

NI-VXI is the name of the National Instruments VXI bus control library. 
You can create applications using NI-VXI to control both VXI and VME 
devices. NI-VXI gives you complete VXI/VME functionality, including 
an API for performing basic VXI/VME data transfers and handling 
VXI/VME interrupts as well as VXI-specific functionality, such as 
doing message-based communication and handling VXIbus triggers.

The NI-VISA/NI-VXI software includes an interactive configuration and 
troubleshooting program, libraries of software routines for test and 
measurement (T&M) programming, interactive control programs for both 
NI-VISA and NI-VXI, a logging utility you can use for debugging your 
applications, and a VXI Resource Manager. You can use this software to 
seamlessly program multiple-mainframe configurations and have software 
compatibility across a variety of controller platforms.
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You can also use the National Instruments LabVIEW application program 
and instrument drivers to ease your programming task. This standardized 
program matches the modular virtual instrument capability of VXI and can 
reduce your VXI software development time. This program features 
extensive libraries of GPIB, Serial, and VXI instrument drivers written to 
take full advantage of direct VXI control. LabVIEW includes all the tools 
needed for instrument control, data acquisition, analysis, and presentation.

LabVIEW is an easy-to-use, graphical programming environment you can 
use to acquire data from thousands of different instruments, including 
IEEE 488.2 devices, VXI devices, serial devices, PLCs, and plug-in data 
acquisition boards. After you have acquired raw data, you can convert it 
into meaningful results using the powerful data analysis routines in 
LabVIEW. LabVIEW also comes with hundreds of instrument drivers, 
which dramatically reduce software development time, because you do not 
need to spend time programming the low-level control of each instrument.
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2
Installation

This chapter contains information about installing your NI VXIpc-882 
controller and components.

Caution Electrostatic discharge can damage your controller. To avoid such damage, 
handle the controller only in a proper ESD-controlled environment.

Installing the NI VXIpc-882
This section contains general installation instructions for the 
NI VXIpc-882 controller. Consult your VXIbus chassis user manual or 
technical reference manual for specific instructions and warnings.

1. Plug in your chassis before installing the controller. The power cord 
grounds the chassis and protects it from electrical damage while you 
are installing the controller.

Caution To protect both yourself and the chassis from electrical hazards, the chassis 
should remain off until you finish installing the controller.

2. Remove or open any doors or covers blocking access to the chassis 
slots.

Caution If the controller is not configured for automatic System Controller detection, be 
certain that the slot you select in your VXIbus chassis matches the controller configuration 
as either a System Controller device or a Non-System Controller device. Installing the 
controller into a slot that does not correspond with the jumper setting can damage the 
controller, the VXIbus backplane, or both. Refer to the Slot 0 Detection section of 
Chapter 3, Configuration and Default Settings, for jumper configuration information.

3. Insert the controller in the desired slot by aligning the top and bottom 
of the controller with the card-edge guides inside the chassis. Slowly 
push the controller straight into the slot until its plug connectors are 
resting on the backplane receptacle connectors. Using slow, evenly 
distributed pressure, press the module straight in until it seats in the 
expansion slot. The front panel of the controller should be even with 
the front panel of the chassis. 
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4. Tighten the retaining screws on the top and bottom edges of the front 
panel.

5. Check the installation.

6. Connect the keyboard and mouse to the USB connectors.

Note Install a noise-suppression ferrite (included in your shipping kit) onto the external 
USB cable when using a USB mouse or keyboard to ensure that your device meets all EMC 
standards applicable to your country. For more information on installing the ferrite, refer 
to KnowledgeBase 4Q0899P6 at ni.com.

7. Connect the DVI-I monitor video cable to the DVI-I connector.

8. Connect devices to ports as required by your system configuration.

9. Replace or close any doors or covers on the chassis.

10. Power on the chassis.

11. The controller should now boot. If the controller does not boot, refer to 
the What if the NI VXIpc-882 does not boot? section of Chapter 6, 
Common Questions and Troubleshooting.

12. On the first boot of the controller, a setup program automatically runs.

13. Follow the prompts in the setup program to fully configure your 
controller.

14. When prompted for the Windows serial number, enter the serial 
number of the operating system from the included certificate.

15. Your controller is now ready for development.
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Figure 2-1 shows an NI VXIpc-882 installed in the system controller slot 
of a National Instruments VXI chassis. You can place VXI devices in any 
other slot.

Figure 2-1.  NI VXIpc-882 Controller Installed in a VXI Chassis

How to Remove the Controller from the VXI Chassis
The NI VXIpc-882 controller is designed for easy handling. To remove the 
controller from the VXI chassis, complete the following steps:

1. Shut down all applications and the operating system.

2. Turn off power.

3. Disconnect devices from the front panel ports as your system 
configuration requires.

4. Remove the retaining screws in the controller front panel.

5. Push the upper ejector handle up and the lower ejector handle down 
until the controller pops out of the backplane connectors.

1 NI VXIpc-882 Controller 2 VXI Chassis

2

1
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6. Slide the controller out of the chassis.

Removing the NI VXIpc-882 Component Side Cover
The NI VXIpc-882 is housed in a metal enclosure comprised of a 
component-side (top), solder-side (bottom), and rear cover to improve 
EMC performance and provide easy handling. Remove the component side 
cover to access the jumper settings.

Complete the following steps to remove the top and rear covers from the 
controller.

1. Remove the 3 Phillips-head screws attaching the rear cover to the 
component-side cover.

2. Remove the 8 screws holding the component-side cover to the solder 
side cover, and the 2 screws holding the component-side cover to the 
module standoffs.

3. Lift the component-side and rear covers away from the module.

Installing and Upgrading RAM
The NI VXIpc-882 uses PC2 5300 DDR2 SDRAM and supports up to 2 GB 
in each of the two RAM sockets.

National Instruments recommends the following size SO-DIMMs for use 
with the NI VXIpc-882 controller (SDRAM):

• PC2-5300 1 GB, 128 MB × 64, CL 5, 1.18 in. max
(NI part number 779302-1024)

• PC2-5300 2 GB, 256 MB × 64, CL 5, 1.18 in. max
(NI part number 780031-2048)

Note National Instruments has tested and verified that the DDR2 SO-DIMMs we sell 
work with the NI VXIpc-882. We recommend you purchase your DDR2 SO-DIMM 
modules from National Instruments. Other off-the-shelf DDR2 SO-DIMM modules 
are not guaranteed to work properly.

To add or replace RAM for the NI VXIpc-882, complete the following 
steps:

1. Remove the NI VXIpc-882 from the chassis. Refer to the removal 
instructions in the How to Remove the Controller from the VXI Chassis 
section.
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2. Remove the component side cover. Refer to the removal instructions in 
the Removing the NI VXIpc-882 Component Side Cover section.

3. Add the SO-DIMM modules to the empty SO-DIMM sockets. Refer to 
Figure 2-2.

Note To optimize both memory capacity and system performance, use the same size and 
speed memory module in each of the two module slots. The use of different size modules 
in each slot is supported, but system performance will be slower than using two matched 
modules. However, two mismatched modules will result in better performance than using 
a single module.

Figure 2-2.  Installing a SO-DIMM in an NI VXIpc-882 Controller

1 SO-DIMM Socket XA1 2 SO-DIMM Module 3 SO-DIMM Socket XA2

3

2

1
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Installing and Removing the Internal Hard Drive
Complete the following steps to remove the internal hard drive from your 
NI VXIpc-882 controller:

1. Remove the controller from the chassis. Refer to the removal 
instructions in the How to Remove the Controller from the VXI Chassis 
section.

2. Remove the component side cover. Refer to the removal instructions 
in the Removing the NI VXIpc-882 Component Side Cover section.

3. Remove the four screws under the solder side cover that hold the hard 
drive in place. You will need a 2mm hex driver to remove the 
M3 button head screws.

Caution Be careful when sliding the hard drive toward the bottom of the controller. The 
hard drive could contact components on the motherboard, causing severe damage to both 
the components and motherboard.

4. Carefully and slowly slide the hard drive toward the bottom of the 
controller to free the pins from the SATA docking connector.

5. When the pins are free of the connector, lift the hard drive off of the 
motherboard.

Note Always handle the hard drive in accordance with the handling instructions outlined 
by the hard drive manufacturer.

Complete the following steps to install the internal hard drive in your 
NI VXIpc-882 controller:

1. Be sure the insulating pad is properly placed on the motherboard over 
the hard drive ground plane.

Caution Use care when installing the hard drive. The hard drive could contact components 
on the motherboard, causing severe damage to both the components and motherboard.

2. Set the hard drive on the motherboard and carefully slide the drive 
forward until it seats firmly in the SATA docking connector. The 
insulating pad should be between the hard drive and the motherboard.

3. Reinstall the four screws that hold the hard drive in place.

4. Reinstall the component side cover.

The controller is now ready to be reinstalled in the VXI mainframe.
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ExpressCard/34
This section provides information on the installation and removal of 
ExpressCard/34 modules.

Installing an ExpressCard/34
You can install an ExpressCard/34 module while the NI VXIpc-882 is 
running. The NI VXIpc-882 will automatically detect the card. 
ExpressCard/34s are generally marked with a symbol or a label to indicate 
which end to insert into the slot. The cards are keyed to prevent incorrect 
insertion.

To install an ExpressCard/34, complete the following steps.

1. Hold the card so the top side is facing left.

2. Insert the card until it is completely seated in its connector. The 
connector has an automatic eject mechanism. If you insert the card and 
it is ejected, simply re-insert the card until it is seated.

If you encounter too much resistance, do not force the card. Check the card 
orientation and try again.

The NI VXIpc-882 will automatically recognize the ExpressCard/34 and 
load the appropriate driver(s). Third-party cards may require that you 
install additional drivers. Contact your ExpressCard/34 vendor for more 
information.

Caution The ExpressCard/34 interface is ESD sensitive. An electrostatic shock on the 
ExpressCard/34 module while it is inserted may cause the controller to lock-up or reboot.

Removing an ExpressCard/34
To remove the ExpressCard/34 module push in the module and then release 
to eject the card. Slide the card out of the slot.

Caution To avoid data loss and other potential issues, stop communication with your 
ExpressCard/34 device before removing it from the NI VXIpc-882. In Windows, use the 
Safely Remove Hardware tool to safely stop the ExpressCard/34.
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3
Configuration and Default 
Settings

Hardware Default Settings
This chapter summarizes the hardware default settings for the 
NI VXIpc-882 for easy reference. The module is set at the factory for the 
most commonly used configuration.

Figure 3-1 and Table 3-1 show the factory-default settings of the 
user-configurable jumpers on the NI VXIpc-882 controller. Tables 3-2, 
3-3, 3-4, 3-5, and 3-6 show user-configurable settings 

in Measurement & Automation Explorer (MAX).
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Figure 3-1.  NI VXIpc-882 Shipping Configuration Settings

W7—TRIG CARD CLK10 DIR
1-2—OUT
2-3—IN (DFLT)

W2—SMB CLK10 DIR
1-2—IN (DFLT)
2-3—OUT

W3—EXT. SOURCE SELECT
1-2—SMB (DFLT)
2-3—TRIGGER CARD

W4—CLK10 SOURCE SELECT
1-2—INTERNAL OSC (DFLT)
2-3—EXTERNAL SOURCE

W5—MITE CONFIG
1-2—FACTORY
2-3—USER (DFLT)
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W8—MITE SELF CONFIG
1-2—DISABLE
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Note Do not adjust any jumpers or switches not listed in Table 3-1 or that are not 
documented in this manual unless directed by National Instruments. Other configuration 
jumpers are shown in the event National Instruments technical support needs to make 
adjustments to your settings.

Default Software Settings
The following hardware configurations are available through 
Measurement & Automation Explorer (MAX).

Table 3-1.  NI VXIpc-882 Controller Hardware Default Settings

Jumper Description Setting

W2 SMB CLK10 DIR 1–2 In (Default)
2–3 Out

W3 External CLK10 Source Select 1–2 SMB (Default)
2–3 Trigger Card

W4 CLK10 Source Select 1–2 Internal Osc. (Default)
2–3 External Source

W5 MITE Configuration 1–2 Factory
2–3 User (Default)

W7 Trigger Card CLK10 Direction 1–2 Out
2–3 IN (Default)

W8 MITE Self Configuration 1–2 Disable
2–3 Enable (Default)

J2 Slot 0 Detect 1–2 Non-Slot 0
3–4 Auto Detect (Default)
5–6 Slot 0

Table 3-2.  MAX Device Tab Default Settings

Editor Field Default Setting

Device class Message-based

Number of handlers 1
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Table 3-3.  MAX Shared Memory Tab Default Settings

Editor Field Default Setting

Don’t share memory

A24/A32 write posting Enabled

Table 3-4.  MAX VXI Bus Tab Default Settings

Editor Field Default Setting

Bus timeout value 500 μs

VXI retry generation Enabled

Automatic retries Enabled

VXI transfer limit 256

A24/A32 write posting Enabled

Requester mode Release on Request

Request level 3

Operate as fair requester Enabled

Bus arbitration mode Prioritized

Arbiter timeout Disabled

Table 3-5.  MAX PCI Tab Default Settings

Editor Field Default Setting

Low-level register access
API support

Enabled

User window size 2 MB

DMA setting Enable DMA on this controller



Chapter 3 Configuration and Default Settings

© National Instruments Corporation 3-5 NI VXIpc-882 User Manual

The following hardware configuration settings are user configurable.

• Slot 0 detection

• VXIbus CLK10 routing

• SMB Trigger I/O

• Backplane trigger I/O

For the configuration switch locations and default settings, see Figure 3-1, 
NI VXIpc-882 Shipping Configuration Settings.

Note Do not attempt an alternate setting unless you are familiar with its purpose. 
In addition, do not reconfigure any switches or jumpers not described in this appendix 
unless directed by National Instruments support.

Slot 0 Detection
The NI VXIpc-882 controller is configured at the factory to automatically 
detect if it is installed in Slot 0 of a VXI mainframe. With automatic System 
Controller slot detection the NI VXIpc-882 controller can be installed in 
any VXIbus slot.

The NI VXIpc-882 controller can be manually configured for either System 
Controller or Non-System Controller operation by defeating the automatic 
detection circuitry. Use the three position jumper J2 as shown in Figure 3-2 
to select between automatic detection, System Controller, or Non-System 
Controller.

Table 3-6.  MAX SMB Tab Default Settings

Editor Field Default Setting

CLK10 50 Ω termination Disabled

Invert CLK10 polarity Enabled

TRIG IN 50 Ω termination Disabled
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Figure 3-2.  Slot 0 Detection through the J2 Jumper

Caution Do not install a device configured as the System Controller in any slot other 
than Slot 0. When installing into a slot other than Slot 0, first reconfigure it as either a 
Non-System Controller or for automatic detection. Failing to do so may result in damage 
to the NI VXIpc-882 controller and/or the backplane.

When the NI VXIpc-882 controller is installed in Slot 0 of a VXI system it 
becomes the VXIbus System Controller. As the System Controller, the 
NI VXIpc-882 controller has VXIbus Data Transfer Arbiter circuitry that 
accepts bus requests on all four VXIbus request levels, prioritizes the 
requests, and grants the bus to the highest priority requester. As the VXIbus 
System Controller, the NI VXIpc-882 controller also drives the 16 MHz 
VXIbus system clock via an onboard 16 MHz oscillator. As required by the 
specification, when installed in Slot 0, the NI VXIpc-882 controller drives 
CLK10, a differential ECL output, to the VXIbus backplane. When the 
system is not installed in Slot 0 it will only receive the CLK10 signal.

MITE EEPROM

User/Factory Configuration
The EEPROM is divided into two halves—one half is factory configured 
and one half is user configurable. Use jumper W5 to control whether the 
NI VXIpc-882 controller boots off the factory-configured EEPROM 
settings or the user-modified settings. In its default setting, the 
NI VXIpc-882 controller boots off the user-configurable half.

This jumper is useful in the event that the user-configured 
half of the EEPROM becomes corrupted in such a way that the 
NI VXIpc-882 controller boots to an unusable state. By changing this 
jumper setting, you can boot to the factory configuration and get up and 
running again. Use the procedure as described in the How to Fix an Invalid 
EEPROM Configuration section of this manual.

c. Slot 0/
System

Controller

a. Non-Slot 0/
Non-System

Controller

b. Auto Detect
(Default)

1 3 5

2 4 6

J2

1 3 5

2 4 6

J2

1 3 5

2 4 6

J2
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Figure 3-3 shows the configuration settings for EEPROM operation.

Figure 3-3.  EEPROM Configuration

Power-On Self Configuration
The NI VXIpc-882 controller has an onboard EEPROM, which stores 
default register values for the VXI circuitry. These values are loaded when 
you power up the computer. The values read from the EEPROM program 
the PCI interface and the VXIbus registers so that the VXI interface is ready 
to respond to Resource Manager accesses within the required 5 seconds of 
SYSRST# deasserting.

You can disable this power-on self-configuration (POSC) circuit by 
changing switch W8. Although this makes the VXI circuitry unusable, 
it is sometimes helpful in debugging address and interrupt conflicts 
with add-in boards. In general, however, you should leave W8 in its 
factory-default setting. Figure 3-4 shows the possible configurations 
for W8.

Figure 3-4.  Power-on Self Configuration Status

How to Fix an Invalid EEPROM Configuration
Use MAX under Windows to edit the NI VXIpc-882 controller 
configuration. Some of these settings are stored in files that the NI-VXI 
software reads, while other settings are stored directly in the NI VXIpc-882 
controller EEPROM.

Certain EEPROM configurations, including invalid configurations, can 
lock up your computer while it is booting. Generally, only the size and 

a. Boot from User
Configuration (Default)

b. Boot from Protected
Configuration

W5 W5

2
3

1
2
3

1

a. Enable (default) b. Disable

W8
2 31

W8
2 31
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location of the memory windows can cause the NI VXIpc-882 controller to 
lock up your system. For example, many PCI-based computers will not 
boot if a board in its system requests more memory space than the computer 
can allocate. If you encounter this situation, you should reduce the size of 
the NI VXIpc-882 controller user memory window. The EEPROM can 
become corrupted if the NI VXIpc-882 controller is shut down while it is 
updating the EEPROM.

If one of these situations occurs after you change the configuration, 
complete the following steps to reconfigure the NI VXIpc-882 controller.

1. Power off your computer.

Caution To protect both yourself and the mainframe from electrical hazards, 
the mainframe should remain off until you finish changing the settings on the 
NI VXIpc-882 controller.

2. Change jumper W5 to the position shown in Figure 3-3b to restore the 
factory configuration.

3. Power on the computer. The computer should boot this time because 
the factory-default configuration is being used to initialize the 
NI VXIpc-882 controller.

4. Run your software configuration utility to re-adjust the NI VXIpc-882 
controller configuration.

5. After saving the configuration, exit Windows and power off the 
computer.

6. Change jumper W5 to the default position, as shown in Figure 3-3a.

7. Power on the computer. If the computer does not boot with this 
configuration, you will need to repeat these steps, modifying your 
configuration until a final configuration is reached.

VXIbus CLK10 Routing
When the NI VXIpc-882 controller is installed in Slot 0 of your mainframe, 
it supplies the VXIbus CLK10 signal. Three different sources for CLK10 
are available with the NI VXIpc-882:

• The internal 10 MHz ±50 ppm CLK10 oscillator. This is the default 
CLK10 source.

• The front panel CLK10 SMB. When configured as an input the front 
panel SMB allows an external source to be used as the source for the 
VXIbus CLK10 signal.
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• The front panel TRIG/CLK PORT A(B). CLK10 can be routed into the 
NI VXIpc-882 from another NI VXIpc-882 through the TRIG/CLK 
PORT A(B) on the front panel. Onboard jumpers are used to set this 
configuration.

Front Panel SMB Direction Control

W2—SMB CLK10 Direction
This jumper allows you to configure the front panel SMB connector on the 
NI VXIpc-882 controller.

The default jumper position, shown in Figure 3-5a, IN, shuts off CLK10 to 
the front panel SMB connector. Use jumpers W4 and W3 to configure the 
front panel SMB as an input for CLK10. In non-Slot 0 operation the SMB 
cannot be configured as an input as only the Slot 0 controller is allowed to 
supply CLK10 to the VXI backplane.

Setting the W2 jumper to OUT, as shown in Figure 3-5b, routes the VXIbus 
CLK10 to the front panel SMB connector. In non-Slot 0 operation this 
jumper will also route the VXIbus CLK10 out of the front panel SMB 
connector.

Figure 3-5.  Setting the Front Panel CLK10 SMB Direction with Jumper W2

Selecting the CLK10 Source

W3—External CLK10 Source Select
When W4—CLK10 Source Select is set to select an external CLK10 
source, W3 is used to select between two external CLK10 sources.

• The default setting, shown in Figure 3-6a, SMB, selects the front panel 
SMB connector as the external CLK10 source. There is no need to set 
the direction of the SMB with jumper W2 as the controller will set the 
SMB as an input for you.

a. IN (default) b. OUT

Set this jumper to OUT to route
CLK10 out of the front panel
SMB connector.

Setting this jumper to IN turns off
the SMB. Use jumpers W3 and W4
to configure the SMB as an input
when in Slot 0 operation.

1

2

3

1

2

3

W2 W2
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• Set the W3 jumper to Trigger Card, shown in Figure 3-6b, to select 
the CLK10 source as the TRIG/CLK PORT A(B) on the 
NI VXIpc-882 front panel. When selecting the trigger card as the 
CLK10 input source be sure to set jumper W7 to set the direction of 
CLK10 through the TRIG/CLK PORT A(B).

Figure 3-6.  Selecting the External CLK10 Source with the W3 Jumper

W4—CLK10 Source Select
In Slot 0 operation the CLK10 Source Select jumper allows you to select 
the source for the VXIbus CLK10 that is routed to the backplane.

The default setting, Internal Oscillator, shown in Figure 3-7a, uses the 
internal 10MHz ±50 ppm oscillator as the VXIbus CLK10 source. 

Set the W4 jumper to External Source, shown in Figure 3-7b, to use the 
front panel SMB or the Trigger Card as the CLK10 source. Jumper W3 
External CLK10 Source Select is used in conjunction with W4 when W4 is 
set to select an external oscillator as the VXIbus CLK10 source.

Figure 3-7.  Selecting the CLK10 Source with the W4 Jumper

a. Front Panel
SMB Connector

(Default)

b. Front Panel
TRIGGER CARD

When W3 is set to select the
TRIGGER CARD as the CLK10
source, use jumper W7 to set
the direction of CLK10 through
the TRIG/CLK PORT.

1

2

3

1

2

3

W3 W3

a. Internal
10 MHz

Oscillator
(Default)

b. External
10 MHz
Source

When W4 is set to select an external
CLK10 source, use jumper W3 to select
between the front panel SMB connector
or the TRIG/CLK PORT A(B).

W4 W4

1

2

3

1

2

3
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TRIG/CLK PORT A(B) Direction

W7—Trigger Card CLK10 Dir
This jumper allows you to configure the direction of CLK10 through the 
TRIG/CLK PORT A(B).

• In Slot 0 operation with jumpers W4 set for an external source and W3 
set for the front panel TRIG/CLK PORT A(B) set this jumper to IN, as 
shown in Figure 3-8a, to route CLK10 in from another NI VXIpc-882 
to the VXI backplane. In non-slot 0 operation the IN setting has no 
effect.

• In Slot 0 and non-Slot 0 operation setting this jumper to OUT, 
as shown in Figure 3-8b, routes the VXIbus CLK10 out of the 
TRIG/CLK PORT A(B).

Figure 3-8.  Setting the TRIG/CLK PORT A(B) Direction with Jumper W7

Optional CLK10 Settings

Inverting CLK10
If the front panel SMB connector EXT CLK is configured as an output this 
software setting provides the capability to invert the clock output. This 
setting can be found in the hardware configuration panels in MAX as 
shown in Figure 3-9.

Set this jumper to OUT to route CLK10
out of the TRIGGER CARD.

Set this jumper to IN when the NI VXIpc-882
is in Slot 0 and W3 and W4 are configured to
select the TRIGGER CARD as the external
CLK10 source. Otherwise leave W7 set to IN
for other W3 and W4 combinations.

b. OUT

1

2

3

W7

a. IN
(Default)

1

2

3

W7
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Figure 3-9.  Inverting the CLK10 Signal through MAX

CLK10 Termination
If the front panel SMB connector EXT CLK is configured as an input this 
software setting can enable 50 Ω parallel termination. This setting can be 
found in the hardware configuration panels in MAX, as shown in 
Figure 3-9.

Trigger Input Termination
Optional software enabled 50 Ω parallel termination is available for the 
front panel trigger input. This setting can be found in the hardware 
configuration panels in MAX, as shown in Figure 3-9.

Note Parallel termination is not necessary when the signal is driven by a 50 Ω source, such 
as an NI VXIpc-882 controller.
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BIOS Configuration
You can change the NI VXIpc-882 configuration settings in the BIOS 
setup. The BIOS is the low-level interface between the hardware and PC 
software that configures and tests your hardware when you boot the system. 
The BIOS setup program includes menus for configuring settings and 
enabling NI VXIpc-882 controller features.

Most users do not need to use the BIOS setup program, as the 
NI VXIpc-882 controller ships with default settings that work well for most 
configurations.

Caution Changing BIOS settings may lead to incorrect controller behavior and possibly 
an unbootable controller. If this happens, follow the instructions for restoring default 
settings in the System CMOS section. In general, do not change a setting unless you are 
absolutely certain what it does.

Entering BIOS Setup
To start the BIOS setup utility, complete the following steps:

1. Power on or reboot your NI VXIpc-882 controller.

2. When the message Press <DEL> to enter SETUP appears, press 
the Delete key on the keyboard. The message Entering Setup 
appears, and the setup program is loaded after a short delay.

3. When you first enter the BIOS setup program, it displays the Main 
menu.

Use the following keys to navigate through the BIOS setup:

• Left Arrow, Right Arrow—Use these keys to move between the 
different setup menus. If you are in a submenu, these keys have no 
effect, and you need to press <Esc> to leave the submenu first. (To use 
the arrows on the numeric keypad, you must turn off Num Lock.)

• Up Arrow, Down Arrow—Use these keys to move between the 
options within a setup menu. (To use the arrows on the numeric 
keypad, you must turn off Num Lock.)

• <Enter>—Use this key either to enter a submenu or display all 
available settings for a highlighted configuration option.

• <Esc>—Use this key to return the parent menu of a submenu. 
At the top-level menus, this key serves as a shortcut to the Exit menu.



Chapter 3 Configuration and Default Settings

NI VXIpc-882 User Manual 3-14 ni.com

• <+> and <–>—Use these keys to cycle between all available settings 
for a selected configuration option.

• <Tab>—Use this key to select time and date fields.

Main Setup Menu
The most commonly accessed and modified BIOS settings are in the Main 
setup menu. The Main setup menu includes the following settings:

• System Time & Date—This setting controls the time of day, which is 
stored in a battery-backed real-time clock. Most operating systems 
also include a way to change this setting. Use <+> and <–> in 
conjunction with <Enter> and <Tab> to change these values.

• Require Keyboard to Boot—When Enabled, a missing or 
malfunctioning keyboard causes the BIOS to halt with an error. When 
Disabled, the BIOS allows booting without a keyboard. If you are 
using a USB keyboard, you may attach it at any time during the 
powered up state. To use this controller in a “headless” mode, you must 
set this option to Disabled. The default value is Enabled.

Note Attaching a USB-to-PS/2 keyboard adapter may allow the system to boot even if no 
PS/2 keyboard is attached.

• Num Lock—This setting indicates whether you turn on Num Lock at 
boot time. The default value is On.

• SATA Port 0/1—This item displays the SATA devices detected in the 
system. Normally, you do not need to modify this item. However, if a 
SATA device is not autodetected properly, you can specify it manually 
by pressing <Enter> on the item.

• IDE Channel 0 Master/Slave—These items display the IDE/ATA 
devices detected in the system. Normally, you do not need to modify 
these items. However, if an IDE/ATA device is not autodetected 
properly, you can specify it manually by pressing <Enter> on an item.

• System Information—This setting displays a screen containing 
important system information about the NI VXIpc-882 controller.

Advanced Setup Menu
This menu contains BIOS settings that normally do not require 
modification. If you have specific problems such as unbootable disks 
or resource conflicts, you may need to examine these settings.
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Caution Changing settings in this menu may result in an unstable or unbootable controller. 
If this happens, follow the procedures outlined in the System CMOS section to restore 
BIOS settings to their factory defaults.

The Advanced setup menu includes the following settings:

• Reset Configuration Data—A portion of the EEPROM on the 
controller is designated as the Extended System Configuration Data 
region (ESCD). The BIOS and Plug-and-Play operating systems use 
this table to store the Last Known Good configuration of system 
peripherals. If you experience resource conflicts or peripheral 
malfunction, set this setting to Yes to force the BIOS to recreate the 
ESCD on the next reboot. This is rarely necessary.

• Integrated Peripherals—Use this setting to bring up the Integrated 
Peripherals submenu. (Refer to the Integrated Peripherals Submenu 
section.)

• Quick Boot Mode—When you enable this option, certain lengthy 
BIOS tests that rarely fail are skipped to shorten controller boot time. 
The default is Enabled.

• Summary Screen—This setting controls the display of the summary 
screen shown after BIOS completes its initialization, but before 
booting takes place. You can disable this screen in the interest of 
shortening controller boot time. The default is Disabled.

• PXE Network Boot—This setting enables the option for booting from 
a network PXE server on the subnet. The default is Disabled.

Integrated Peripherals Submenu
Use this submenu to apply nondefault configurations to the front panel 
peripherals of an NI VXIpc-882 controller. Normally, you do not need 
to modify these settings, as the factory default settings provide the most 
compatible and optimal configuration possible.

• Serial Port A—This setting enables or disables COM1. You also can 
change this setting to Enabled and modify the base address and 
Interrupt Request Level (IRQ) of a port. The default is Auto, which 
places COM1 at 0x3F8 IRQ 4.

• Parallel Port—Use this setting to enable or disable LPT1. You also 
can change this setting to Enabled and modify the base address, 
IRQ level, and ISA Direct Memory Access (DMA) channel of the 
port. The default is Auto, which places LPT1 at 0x378, IRQ 7, using 
ISA DMA Channel 3 if necessary.
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• Parallel Port Mode—The PC industry has created several different 
modes of operation for this port over the years. Usually, the default 
setting works for all applications. However, if a parallel port device 
specifically requires a nondefault setting, you can change it here. 
The default is Bidirectional, for full IEEE 1284 capabilities.

• Legacy USB Support—Use this setting to use a USB keyboard and 
mouse as if they were standard PS/2-style peripherals. You must enable 
this setting to use these devices in operating systems with no USB 
support and to boot from a USB floppy or CD-ROM. The BIOS setup 
screen always works with USB keyboards regardless of this setting. 
The default is Enabled.

• SATA Mode—This setting determines whether the SATA controller 
operates in Enhanced or Compatible mode. Enhanced mode 
provides the advanced features of a SATA controller, while 
Compatible mode provides legacy backwards compatibility with 
standard ATA for operating systems that do not natively support SATA. 
The default setting is Enhanced.

• AHCI Configuration—This setting determines whether AHCI mode 
is Enabled or Disabled for the SATA port. Because some operating 
systems do not support AHCI mode, you can use this setting to disable 
AHCI mode so that non-compatible OSes function correctly. The 
default setting is Enabled.

• Multi-Core Processing—This setting determines whether or not the 
second core processor on the Intel® Core™ 2 Duo T7400 is enabled. 
The default setting is Enabled.

• Monitor DDC—This setting determines how the monitor DDC is 
routed. Use this setting to select whether or not the DDC is routed for 
an Analog monitor or a DVI monitor. In order to use a DVI monitor, 
this setting must be set to DVI. An analog monitor, however, will 
function with this option set to either Analog or DVI. The DDC 
communication path is only enabled when set to Analog for an analog 
monitor, so certain advanced features of your analog monitor may only 
be enabled when routing DDC to Analog. The default setting is DVI.

• Force IGD Primary—This setting determines how the BIOS 
prioritizes video controllers when external video cards are present in 
the system. During POST, only one device can act as the video display 
device. When set to Enabled, the BIOS allows the integrated graphics 
device to remain the video display device. When set to Disabled, the 
BIOS allows an external graphics card, if present, to act as the default 
video display device. Note that even when set to Disabled, the 
integrated graphics device still acts as the video display device if it is 
the only one available in the system. The default setting is Disabled.
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• ExpressCard Hot-Plug Resources—This setting determines whether 
or not resource pre-allocation is Enabled or Disabled for the 
ExpressCard/34 port. When this setting is Enabled, the BIOS will 
pre-allocate memory space, I/O space, and PCI bus numbers for the 
ExpressCard/34 port, allowing non-PCI Express-aware operating 
systems to support hot-plugging ExpressCard/34 devices. When this 
setting is Disabled, no resources will be pre-allocated, and you may 
need to restart the OS when hot-plugging an ExpressCard/34 device. 
The default setting is Enabled.

• Hot-Plug Bus Gap—This setting determines the number of PCI buses 
that will be reserved by the BIOS for ExpressCard/34 PCI-PCI bridges 
that may be hot-plugged in the ExpressCard/34 slot. This setting is 
only applicable if ExpressCard Hot-Plug Resources is set to 
Enabled. The default value for this setting is 8 PCI buses.

• I/O—This setting determines the amount of I/O space, in bytes, that 
will be reserved by the BIOS for PCI-PCI bridges that may be 
hot-plugged in the ExpressCard/34 slot. This setting is only applicable 
if ExpressCard Hot-Plug Resources is set to Enabled. The default 
value for this setting is 4096 bytes of I/O space.

• Memory—This setting determines the amount of memory space, in 
bytes, that will be reserved by the BIOS for PCI-PCI bridges that may 
be hot-plugged in the ExpressCard/34 slot. This setting is only 
applicable if ExpressCard Hot-Plug Resources is set to Enabled. 
The default value for this setting is 32 megabytes of memory.

• Pre-fetchable Memory—This setting determines the amount of 
pre-fetchable memory space, in bytes, that will be reserved by the 
BIOS for PCI-PCI bridges that may be hot-plugged in the 
ExpressCard/34 slot. This setting is only applicable if ExpressCard 
Hot-Plug Resources is set to Enabled. The default value for this 
setting is 32 megabytes of pre-fetchable memory.

Security Menu
Use this menu to enable BIOS security options.

• Set User Password—This setting allows you to specify a password 
that must be entered to boot the system. To activate this feature, you 
must first specify a Supervisor password and enable the Password on 
boot feature. By default, no password is specified.

• Set Supervisor Password—This setting allows you to specify a 
password that must be entered to access the BIOS setup options. By 
default, no password is specified.
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• Password on Boot—This setting controls whether or not a password 
is required to boot the system. If enabled, the user must enter the User 
Password to boot the system. The default setting is Disabled.

• Write Protect Boot Sector—When set to Yes, this setting prevents 
modification of a hard disk boot sector via INT 13h services, which 
may help prevent certain computer viruses from infecting the 
controller. This setting does not prevent boot sector modification by 
32-bit operating system drivers that access the hard disk directly. The 
default is No.

Boot Setup Menu
This screen displays the boot order of devices associated with the 
controller. The BIOS proceeds down the Boot priority order list in search 
of a bootable device. Devices under the Excluded from boot order list 
will not be used for booting. If the BIOS fails to find any bootable device, 
the message Operating System Not Found is displayed, and the 
system halts.

• PCI SCSI—A SCSI drive (hard disk drive or CD-ROM).

• IDE HDD—The internal hard drive.

• USB HDD—A USB based flash drive or hard disk drive.

• USB CDROM—A USB based CD-ROM drive.

• USB FDC—A USB based floppy disk drive.

• PCI LAN—A PXE Network boot device, if PXE Network Boot is 
enabled on the Advanced menu.

Exiting BIOS Setup
The Exit setup menu includes all available options for exiting, saving, and 
loading the BIOS default configuration. As an alternative to this screen, 
press <F9> to load BIOS default settings and <F10> to save changes and 
exit setup.

The Exit setup menu includes the following settings:

• Exit Saving Changes—Any changes made to BIOS settings are stored 
in the battery-backed System CMOS. The setup program then exits 
and reboots the controller.

• Exit Discarding Changes—Any changes made to BIOS settings 
during this session of the BIOS setup program are discarded. The setup 
program then exits and boots the controller without rebooting first.
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• Load Setup Defaults—This setting restores all BIOS settings to the 
factory default. This is useful if the controller exhibits unpredictable 
behavior due to an incorrect or inappropriate BIOS setting. Notice 
that any nondefault settings such as boot order, passwords, and 
keyboardless operation are restored to their factory defaults. This may 
produce undesirable behavior, and in heavily customized cases, may 
cause the controller to malfunction or fail to boot.

• Discard Changes—Any changes made to BIOS settings during 
this session of the BIOS setup program are discarded. Unlike Exit 
Discarding Changes, however, the BIOS setup continues to be active.

• Save Changes—Changes made to BIOS settings during this session 
are committed to battery-backed System CMOS. The setup program 
remains active, allowing further changes.

System CMOS
The NI VXIpc-882 contains a backed-up memory used to store BIOS 
configuration information.

Complete the following steps to clear the CMOS contents:

1. Power off the chassis.

2. Remove the controller from the chassis.

3. Move the jumper on W1 from pins 1–2 to pins 2–3, as shown in 
Figure 3-10.

4. Wait one second. Move the jumper back to pins 1–2.

5. Reinstall the controller in the chassis. 

Caution Do not leave the jumper on pins 2–3. Doing so decreases battery life. In addition, 
leaving the jumper on the pins prevents the controller from booting.
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Figure 3-10.  Clearing the CMOS Contents

Software Configuration

Measurement and Automation Explorer (MAX)
Measurement and Automation Explorer (MAX) is the utility for 
configuring most National Instruments hardware and software. You can 
use this utility to configure your NI VXIpc-882 controller’s various 
software and hardware features.

The following sections describe hardware configuration settings available 
with NI-VXI 3.6. If you are using a later version of NI-VXI, you may find 
some differences between your settings and those described in this section. 

1  Normal Operation (Default) 2 Clear CMOS Contents 3 Pin 1

1 2

3
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Default MAX Settings
The General tab for the VXIpc MAX hardware configuration contains two 
options for quickly configuring your VXIpc controller. You can use the 
Quick Configuration table to select from a few commonly used 
configurations. The default setting lists Current Board Configuration, 
which means the current hardware configuration is set according to the last 
user modifications made. Table 3-7 lists the configurations you can select. 

Note Whenever you open the hardware configuration, MAX reports that the VXIpc is 
in Current Board Configuration. This means that if you select one of the common 
configurations such as LA 5 Message Based and save the configuration, the next time you 
open MAX, it will not report that the Current Board Configuration is LA 5 Message 
Based as you might expect. If you have used a common configuration setting, closed and 
reopened MAX, and want to verify the current VXIpc configuration, you must check each 
tab for the current controller configuration.

In MAX, you can load a VXIpc configuration from a file or save the current 
configuration for future use. You may execute this option by selecting one 
of the options in the General tab in the MAX hardware configuration.

Table 3-7.  VXIpc MAX General Tab Settings

Menu Selection Explanation

Current Board Configuration (Default) Last configuration 
loaded

LA 5 Message Based Sets controller to message-based 
device at logical address 5

LA 5 Register Based, 
Shared RAM

Sets controller to register-based 
device at logical address 5, 
sharing RAM

Share 128 KB of Memory Shares 128 KB of RAM
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You can use the Device tab to set some basic VXI properties of your device. 
Table 3-8 lists the default settings for this tab on your VXIpc controller.

You can use the Shared Memory tab to configure the amount of memory 
you make available to the VXI bus. Table 3-9 lists the default settings for 
this tab on your VXIpc controller. The default setting on the controller is to 
share no system RAM. After you select one of the shared RAM options, 
you can select the amount of RAM you want to share.

You can use the VXI bus tab to set various configurations related to VXI 
bus control. Table 3-10 lists the default settings for this tab on your VXIpc 
controller.

Table 3-8.  VXIpc MAX Device Tab Default Settings

Setting Default Value

Logical Address 0

Device Class Message Based

Interrupt Configuration: Number of Handlers 1

Table 3-9.  VXIpc MAX Shared Memory Tab Default Settings

Setting Default Value

Shared Memory Do Not Share Memory

Table 3-10.  VXIpc MAX VXI Bus Tab Default Settings

Setting Default Value

Bus Settings: Bus Timeout 500 μs

Bus Requester: Release on Request Checked

Bus Requester: Request Level 3

Bus Requester: Operate as Fair Requester Checked

Bus Arbitration: Prioritized Checked
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You can use the PCI tab to set various configurations associated with the 
PCI resources your VXI interface uses. Table 3-11 lists the default settings 
for this tab on your VXIpc controller.

You can use the SMB tab to configure the options associated with the SMB 
connectors on the front panel of your VXIpc controller. Table 3-12 lists the 
default settings for this tab on your VXIpc controller.

VXI-MXI-2 Default Settings
This section summarizes the software default settings for the VXI-MXI-2. 
This information is included for your convenience in case you have any of 
these modules in your system.

Table 3-11.  VXIpc MAX PCI Tab Default Settings

Setting Default Value

User Window: Enable Low-Level 
Register Access API Support

Checked

User Window Size 2 MB

DMA Setting: Enable DMA on 
this Controller

Enabled

Table 3-12.  VXIpc MAX SMB Tab Default Settings

Setting Default Value

Clock 10 Settings: Enable 50 Ohm 
Termination

Not Checked

Table 3-13.  VXI-MXI-2 General Tab Default Settings

Setting Default Value

Common Board Configurations Current Board Configuration

Table 3-14.  VXI-MXI-2 Device Tab Default Settings

Setting Default Value

Logical Address Selection Use DIP Switch to Set the 
Logical Address

Shared Memory: Address Space A24
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Shared Memory: Requested 
Memory

16 KB

Operate in Interlocked Mode Checked

Table 3-15.  VXI-MXI-2 MXI-2 Bus Tab Default Settings

Setting Default Value

Bus Settings: Bus Timeout 1 ms

System Controller Auto Detect

Advanced: Bus Protocols: 
MXI Transfer Limit

Unlimited

Advanced: Bus Protocols: 
Perform Parity Checking

Checked

Advanced: MXI-2 CLK 10 Signal Receive

Table 3-16.  VXI-MXI-2 VXI Bus Tab Default Settings

Setting Default Value

Bus Settings: Bus Timeout 125 μs

Bus Requester: Release on 
Request

Checked

Slot 0 Configuration: Auto-Detect 
(Recommended)

Checked

Advanced: Bus Protocols: 
Transfer Limit

256

Advanced: Bus Arbitration: 
Arbiter Type: Priority

Checked

Advanced: Bus Arbitration: 
Operate as Fair Requester

Checked

Table 3-14.  VXI-MXI-2 Device Tab Default Settings (Continued)

Setting Default Value
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PCI-MXI-2 Default Settings
This section summarizes the software default settings for the PCI-MXI-2. 
This information is included for your convenience in case you have any of 
these modules in your system.

Advanced: Bus Arbitration: 
Enable Arbiter Timeout

Checked

Advanced: Bus Arbitration: 
Request Level

3

Table 3-17.  PCI-MXI-2 General Tab Default Settings

Setting Default Value

Common Board Configurations Current Board Configuration

Table 3-18.  PCI-MXI-2 Device Tab Default Settings

Setting Default Value

Logical Address 0

Device Class Message Based

Interrupt Configuration: Number of Handlers 1

Table 3-19.  PCI-MXI-2 Shared Memory Tab Default Settings

Setting Default Value

Share Memory in A32 Space Selected

Shared Memory: Shared RAM Size 2 GB

Shared Memory: Reserve Physical 
Memory (KB)

0

Table 3-16.  VXI-MXI-2 VXI Bus Tab Default Settings (Continued)

Setting Default Value
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Advanced: Lower Half Window: Map 
Lower Half To

System Memory

Advance: Upper Half Window: Map 
Upper Half To

System Memory

Table 3-20.  PCI-MXI-2 MXI-2 Bus Tab Default Settings

Setting Default Value

Bus Settings: Bus Timeout 1 ms

System Controller Auto Detect

Advanced: Bus Protocols: Enable 
MXI-2 Auto Retry

Checked

Advanced: Bus Protocols: 
Enabled A24/A32 Write Posting

Checked

Advanced: Bus Protocols: MXI 
Transfer Limit

256

Advanced: MXI-2 CLK 10 Signal Receive

Table 3-21.  PCI-MXI-2 PCI Tab Default Settings

Setting Default Value

User Window: Enable Low-Level 
Register Access API Support

Checked

User Window: User Window Size 64 KB

Enable PCI Expansion ROM Checked

DMA Setting Enable DMA on this Controller

Table 3-19.  PCI-MXI-2 Shared Memory Tab Default Settings (Continued)

Setting Default Value
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Front Panel SMB ExtClk Setup
The NI VXIpc-882 computers have an SMB connector on the front panel 
for an external clock. Onboard programmable logic can configure the 
NI VXIpc-882 to drive its 10 MHz VXI CLK10 signal to this connector as 
an output or to use this connector as an input for the 10 MHz VXI CLK10 
signal. In this fashion, you can configure multiple mainframes to operate 
off a single 10 MHz system clock. Refer to the VXIbus CLK10 Routing 
section for information on properly configuring the hardware to use the 
CLK10 routing feature of the NI VXIpc-882.

Front Panel SMB TRGIN/TRGOUT
The NI VXIpc-882 gives programmers full hardware and software control 
over the VXI trigger lines. The NI VXIpc-882 has two SMB trigger I/O 
connectors on its front panel for routing any of the TTL trigger lines 
between the backplane and external devices. The VXI trigger interface is 
based on the advanced MANTIS ASIC developed by National Instruments. 
The MANTIS provides the complete NI VXIpc-882 VXI interface to the 
outer rows of the P2 backplane connector in a single chip. The 
NI VXIpc-882 can respond to all VXI-defined protocols on all P2 TTL and 
ECL trigger lines at the same time. The MANTIS features an internal 
cross-matrix switching system for routing between lines as well as to and 
from the front panel and onboard clocks. An internal counter gives 
sophisticated counting of events and interrupting on trigger edges and 
pulses, as well as generating pulse trains, variable length pulses, and pulse 
stretching.

You have the option to terminate the external trigger input SMB with 50 Ω 
to ground to match the driving source, if necessary. Use MAX to set this 
option.
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4
Developing Your Application

This chapter discusses the software utilities you can use to start developing 
applications that use NI-VXI.

After installing the NI-VXI software, you can begin developing your 
VXI/VME application. Be sure to check the release notes for the latest 
application development notes and changes.

NI-VXI, NI-VISA, and Related Terms
Before you develop your application, it is important to understand the 
difference between NI-VXI, NI-VISA, and similar terms:

• NI-VXI is the software package that ships with National Instruments 
VXI and VME controllers. NI-VXI includes Measurement & 
Automation Explorer (MAX), NI-VISA, NI Spy, Resource Manager 
(Resman), VXI device drivers, and other utilities for configuring and 
controlling your VXI or VME system.

• NI-VISA is the native API for communicating with VXI/VME devices. 
NI-VISA is the National Instruments implementation of the VISA I/O 
standard, which is a common interface to many types of instruments 
(such as VXI, GPIB, PXI, Serial, TCP/IP, and so on). NI-VXI is 
optimized for use through NI-VISA, and we recommend using 
NI-VISA to develop all new VXI/VME applications.

• The NI-VXI API is an optional development environment that is 
not part of the default NI-VXI installation. The NI-VXI API was 
developed before NI-VISA; while NI-VXI still supports the NI-VXI 
API, we recommend using NI-VISA for all new VXI/VME 
applications. If you must develop an application using the older 
NI-VXI API, run the NI-VXI installer and select the appropriate option 
in the custom installation screen. Be sure to review the NI-VXI API 
Notes section later in this chapter.

• The NI-VXI compatibility layer allows older programs that use the 
NI-VXI API to communicate with VXI devices through VISA. Using 
this compatibility layer, older programs can run in NI-VXI 3.0 or later 
without being rewritten to use the VISA interface. This layer installs 
with NI-VXI by default. It should be completely transparent and 
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provide a high level of performance; however, there may be some 
slight changes in behavior for certain applications.

Your software features several system development utilities including 
MAX, Resman, NI Spy, VISA Interactive Control (VISAIC), and VXI 
Interactive Control (VIC, optional). You can also access help and a variety 
of examples to learn how to use NI-VXI for certain tasks.

Each component assists you with one of four development steps: 
configuration, device interaction, programming, and debugging.

You can access the utilities, help files, and release notes through the 
Windows Start menu by opening the National Instruments»VXI or 
National Instruments»VISA program groups.

Configuration
The configuration utilities in your software kit are Resman and MAX.

Resman performs VXI Resource Manager functions as described in the 
VXIbus specification. Resman configures all devices on the VXI backplane 
for operation and allocates memory for devices that request it. Resman does 
not require you to specify any settings; it automatically performs the VXI 
resource management whenever you run it.

Note Power cycling resets all devices, so you must run Resman to reconfigure your 
system every time you cycle the power on the chassis.

MAX presents a graphical display of your entire test and measurement 
system to help you configure various components. When you launch MAX, 
you see all your devices (including VXI) on the screen. You can view the 
properties (such as logical address, address space, and so on) of each device 
by clicking the device in the configuration tree. To see additional 
configuration options for a given device, right-click the device in the 
configuration tree. When you access the properties of most National 
Instruments devices by right-clicking, you can configure the hardware 
settings by selecting Hardware Configuration.

MAX and Resman are designed to work together. You can run Resman 
through MAX by either clicking the Run VXI Resource Manager button 
in the toolbar or right-clicking a specific VXI system on which to run 
Resman (refer to Figure 4-1). You can also select Tools»NI-VXI»VXI 
Resource Manager to run Resman on all VXI systems. From the VXI 
Options dialog in the Tools»NI-VXI menu, you can also use MAX to 
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configure Resman to run on all VXI systems automatically when the 
computer boots. Resman reports to MAX all errors it finds in your system; 
when you view your VXI system in MAX, you can easily spot any errors 
that Resman found while configuring the system.

Figure 4-1.  Right-Click a VXI System in MAX to Run Resman on that System

After Resman detects and configures all your VXI/VME devices, you can 
use MAX to view specific information about each device in your system. 
The default MAX view of a VXI system shows the General tab window, 
which contains a summary of key information about each device, including 
its device name, logical address, model name, and other data.

For more information about MAX, refer to its help by selecting the Help»
Help Topics menu.

Device Interaction
You can interact with your VXI/VME devices using the VISA Interactive 
Control (VISAIC) utility. VISAIC allows you to control your VXI/VME 
devices without using a conventional programming language, LabVIEW, 
or Measurement Studio. You can also control your devices in MAX by 
right-clicking a device name and selecting Open VISA Session.
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Note You can also use VXI Interactive Control Program (VIC) to control your VXI/VME 
devices and develop and debug VXI application programs. VIC is not included in the 
default NI-VXI installation; to install it, select NI-VXI API Development from the 
custom installation screen in the installer.

You can launch VISAIC (or VIC) from the Tools menu in MAX or from 
the VISA or VXI subgroups in Start»Programs»National Instruments.

Try the following in VISAIC: In the tree view, navigate using your mouse 
to the VISA resource for your controller—probably VXI1::0::INSTR, 
representing the VXI system 1, logical address 0 instrument resource (refer 
to Figure 4-2).

Figure 4-2.  Select Your Controller in VISAIC

Open the selected resource and navigate to the Register I/O tab. In this tab, 
you can read registers on your device, such as the VXI device configuration 
registers. Execute the viIn operation (called In in LabVIEW compatibility 
mode) with the default parameters. The Data Value field shows the I/O 
operation result, such as 0x9ff6. The Return Value field shows the 
function status, such as 0 for VI_SUCCESS (see Figure 4-3).
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Figure 4-3.  Successful viIn Access in the VISAIC Register I/O Tab
(This Dialog Box May Look Slightly Different for LabVIEW Users)

If the data value ends in ff6, you have successfully read the National 
Instruments manufacturer ID from your VXI/VME controller’s ID register.

You may now want to read the configuration registers from other VXI 
devices in your system by opening the devices in VISAIC. Try reading a 
register from each device listed in the MAX view of your VXI system. This 
way, you can verify that your VXI controller can access each device in your 
VXI system successfully.

You can also access VXI and VME devices configured in A16, A24, 
or A32 space by opening the VXI MEMACC resource, which is VISA’s 
representation of VXI memory. For more information about VISAIC 
operations and commands, refer to the help in the Help menu and the 
context-sensitive help (such as What’s This?) available by right-clicking 
in any panel.

Programming for VXI
NI-VISA and the NI-VXI API are the two National Instruments 
programming interfaces for accessing your VXI/VME instruments. With 
NI-VXI 3.0 or later, NI-VISA is the native API for communicating with a 
VXI or VME system, and we recommend using it for all new applications. 
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Older programs that use the NI-VXI API now use the NI-VXI-to-NI-VISA 
compatibility layer to communicate with the VXI devices. Using this layer, 
older programs can run in NI-VXI 3.0 or later without being rewritten to 
use the VISA interface. For more information about programming with 
NI-VISA, refer to the NI-VISA Help, which you can find at 
ni.com/support.

Note The NI-VXI API development environment is not installed by default as part of the 
NI-VXI installation. If you must develop an application using the older NI-VXI API, run 
the NI-VXI installer and select the appropriate option in the custom installation screen. 
Be sure to review the NI-VXI API Notes section later in this chapter.

NI-VISA is the National Instruments implementation of the VISA API as 
the VXIplug&play standard defines. It provides a common interface to 
many types of instruments (such as VXI, GPIB, PXI, Serial, TCP/IP, and 
so on) and therefore is especially useful in situations where you are using 
multiple types of instruments.

Both NI-VISA and the NI-VXI API include functions for register-level 
access to VXI instruments and messaging capability to message-based 
devices. You can also use either interface to service asynchronous events 
such as triggers, signals, and interrupts, and also assert them. Compatibility 
with the NI-VXI API is included for legacy applications only—we 
recommend that you write all new VXI/VME applications in VISA.

The best way to learn NI-VISA programming is by reviewing the example 
programs your software includes. The examples directory contains 
working VISA programs that illustrate many different types of 
applications. You can find these examples in the VXIpnp\WinNT\
NIvisa\Examples directory.

If you are just getting started, you should learn how to access registers with 
high-level calls and send messages with word-serial functions. The 
NI-VISA examples for these tasks are HighReg.c and RdWrt.c. Refer 
to the other examples as you try more advanced techniques. Consult the 
NI-VISA Help for additional information on these topics.

Table 4-1 summarizes the topics the example programs address. (All files 
are in the <root directory>\Program Files\National 
Instruments\VXI\NIVXI API directory, in the subdirectories listed in 
Table 4-1.
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Note MAX includes configuration options that affect low-level functions and shared 
memory, as well as trigger mappings and other attributes of your VXI system. Refer to the 
MAX help for information regarding these options.

Optimizing Large VXIbus Transfers
For best performance, keep the following in mind when using viMove() 
or VXImove():

• Make sure your buffers are 32-bit aligned.

• Transfer 32-bit data whenever possible.

• Use VXI block access privileges to significantly improve performance 
to devices that are capable of accepting block transfers.

• To optimize move performance on virtual memory systems, lock the 
user buffer in memory yourself so the move operation does not need to 
lock the buffer.

• To optimize move performance on paged memory systems, use a 
contiguous buffer so the move operation does not need to build a 
scatter-gather list for the user buffer.

Note viMemAlloc() or VXImemAlloc() returns 32-bit aligned, page-locked, 
contiguous buffers which work efficiently with the move operations.

Table 4-1.  NI-VISA/NI-VXI Examples

Coverage NI-VISA Example 
NI-VXI Example 

(Optional)

Message-Based 
Access

RdWrt.c VXIws.c

High-Level 
Register Access

HighReg.c VXIhigh.c

Low-Level 
Register Access

LowReg.c VXIlow.c

Sharing Memory ShareSys.c VXImem.c

Interrupt Handling AsyncIntr.c and 
WaitIntr.c

VXIint.c

Trigger Handling WaitTrig.c VXItrig.c
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Shared Memory
In the Hardware Configuration settings for your controller in MAX, 
you can share memory from your embedded controller on the VXI/VME 
bus. Right-click any setting or consult the MAX help for more information. 
You can access shared memory on your computer using viMemAlloc() in 
VISA (or VXImemAlloc() in the NI-VXI API).

NI-VXI API Notes
The following notes apply only if you are using the NI-VXI API. We 
recommend that all new VXI/VME applications use the NI-VISA API, but 
you can still develop with the older NI-VXI API for compatibility with 
legacy code.

Compiler Symbols
You may need to define certain compiler symbols so that the NI-VXI 
library can work properly with your program. The required symbol 
indicates your operating system platform; for example, VXINT designates 
the application as a Windows Vista/XP/2000/Me/9x/NT application.

Note LabWindows/CVI automatically defines the correct symbol. You do not need to 
define VXINT when using LabWindows/CVI.

The additional symbol BINARY_COMPATIBLE is optional. It ensures that 
the resulting application is binary compatible with other National 
Instruments VXI controllers using the same operating system. This symbol 
may cause a slight performance degradation when you use low-level 
VXIbus access functions.

You can define these symbols using #define statements in your source 
code or using the appropriate option in your compiler (typically either -D 
or /D). If you use #define statements, they must appear in your code 
before the line that includes the NI-VXI API header nivxi.h.

Compatibility Layer Options
Although NI-VXI supports multiple VXI controllers through NI-VISA, the 
NI-VXI API supports only a single controller. To specify which controller 
the emulation layer should use, run MAX. Select Tools»NI-VXI»VXI 
Options. Select the VXI system that will support the emulation layer.

In NI-VXI 3.0 or later, when you enable for triggers or interrupts, only the 
local controller is enabled. In the NI-VXI API functions for enabling 
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triggers and interrupts, the controller parameter is ignored. If you need to 
enable a remote controller for triggers, use the MAX frame resource to map 
the trigger back to the local controller.

The interrupt and trigger routing in the NI-VXI 3.0 or later low-level 
drivers is somewhat different from the default routing in previous versions 
of NI-VXI. Therefore, the compatibility layer may behave differently than 
the original NI-VXI API with regard to these settings. In particular, if you 
are receiving triggers on an external controller, you may need to modify the 
trigger configuration on your extender module using MAX. In general, 
interrupts are routed automatically based on the interrupt configuration the 
resource manager detects. Whether the changed routing behavior affects 
your program is application dependent.

Because VISA is an instrument-centric API, certain functions from the 
more controller-centric NI-VXI API do not match perfectly with a VISA 
counterpart. When an application enables an event with the NI-VXI API 
compatibility layer, each logical address is enabled for that event 
separately. For example, if the application enables an interrupt level, VISA 
will enable the interrupt on each logical address, one at a time, until all the 
devices are enabled. This means that some interrupts could be lost from 
devices with higher numbered logical addresses. MAX provides an 
option for users to pick which logical address is enabled first. Select 
Tools»NI-VXI»VXI Options. Set Prioritized Signal LA to the logical 
address of the device that generates the events. This prevents possible loss 
of events from that device.

Debugging
NI Spy and VISAIC are useful utilities for identifying the causes of 
problems in your application.

NI Spy tracks the calls your application makes to National Instruments 
programming interfaces, including NI-VISA, NI-VXI, and NI-488. NI Spy 
highlights functions that return errors, so during development you can 
quickly spot which functions failed during a program’s execution. NI Spy 
can log the calls your program makes to these drivers so you can check 
them for errors at your convenience, or use the NI Spy log as a reference 
when discussing the problem with National Instruments technical support. 
Figure 4-4 shows an example of a normal error returned from a call to 
viMemAlloc when no memory has been shared.



Chapter 4 Developing Your Application

NI VXIpc-882 User Manual 4-10 ni.com

Figure 4-4.  NI-Spy

VISAIC, discussed in the Device Interaction section of this chapter, is an 
excellent platform for quickly testing instruments and learning how to 
communicate with them. Refer to the NI-VISA Help for more information 
about using VISAIC.

Figure 4-5.  VISAIC
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5
I/O Information

Front Panel Connectors
Table 5-1 lists various peripherals and their corresponding NI VXIpc-882 
external connectors, bus interfaces, and functions.

Table 5-1.  NI VXIpc-882 Peripherals Overview

Peripheral
External 

Connector Function

Video 24-pin D-SUB 
(standard DVI-I)

Integrated with Dynamic Video 
Memory

Serial COM1 RS-232 serial port 
(9-pin D-SUB)

16550 serial port

Gigabit Ethernet Ethernet, RJ45 Ethernet network connection

Parallel Parallel Port
IEEE 1284 Type C miniature

Extended capabilities

USB 4-pin High Speed receptacle 
(four ports)

Universal Serial Bus

Keyboard USB USB-style keyboard

Mouse USB USB-style mouse

VXI TRIG IN, TRIG OUT, EXT 
CLK (three SMB connectors)

Routing VXI triggers to or from the 
backplane trigger bus; routing 
CLK10 to or from the VXI backplane

GPIB device GPIB (IEEE 488.2)
micro D25

General-Purpose Interface Bus

ExpressCard/34 device One ExpressCard/34 slot Interface for ExpressCard/34 devices
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DVI-I
Figure 5-1 shows the location and pinouts for the DVI-I connector on the 
NI VXIpc-882. Table 5-2 lists and describes the DVI-I connector signals.

Figure 5-1.  DVI-I Connector Location and Pinout

Table 5-2.  DVI-I Connector Signals

Pin Signal Name

1 TMDS Data2–

2 TMDS Data2+

3 TMDS Data2/4 Shield

4 Reserved

5 Reserved

6 DDC Clock [SCL]

7 DDC Data [SDA]

8 Analog vertical sync

9 TMDS Data1–

1 9 17

C4

8 24
C3

C2

C1
C5
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10 TMDS Data1+

11 TMDS Data1/3 Shield

12 Reserved

13 Reserved

14 +5 V Power

15 Ground (for +5 V)

16 Hot Plug Detect

17 TMDS Data0–

18 TMDSData0+

19 TMDS Data0/5 Shield

20 Reserved

21 Reserved

22 TMDS Clock Shield

23 TMDS Clock+

24 TMDS Clock–

C1 Analog Red

C2 Analog Green

C3 Analog Blue

C4 Analog Horizontal Sync

C5 Analog GND Return: (analog R, G, B)

Table 5-2.  DVI-I Connector Signals (Continued)

Pin Signal Name
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COM1
Figure 5-2 shows the location and pinouts for the COM1 connector on the 
NI VXIpc-882. Table 5-3 lists and describes the COM1 connector signal.

Figure 5-2.  COM1 Connector Location and Pinout

Table 5-3.  COM1 Connector Signals

Pin Signal Name Signal Description

1 DCD Data Carrier Detect

2 RXD Receive Data

3 TXD Transmit Data

4 DTR Data Terminal Ready

5 GND Ground

6 DSR Data Set Ready

7 RTS Ready to Send

8 CTS Clear to Send

9 RI Ring Indicator

1

59

6

COM1
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Ethernet
Figure 5-3 shows the location and pinouts for the Ethernet connector on the 
NI VXIpc-882. Table 5-4 lists and describes the Ethernet connector 
signals.

Figure 5-3.  Ethernet Connector Location and Pinout

Table 5-4.  Ethernet Connector Signals

Pin Fast Ethernet Gigabit Ethernet

1 TX+ TX_A+

2 TX– TX_A–

3 RX+ RX_B+

4 NC TX_C+

5 NC TX_C–

6 RX– RX_B–

7 NC RX_D+

8 NC RX_D–

Ethernet

1

8
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Note The Ethernet controller can perform automatic crossover, thus eliminating the need 
for crossover cables.

Table 5-5.  10/100/1000 LAN Connector LED States

LED Color LED State Condition

Top Green

Off LAN link is not established.

On (steady state) LAN link is established.

On (pulsing) The controller is communicating with 
another computer on the LAN.

Bottom

Unlit Off 10 Mbit/sec data rate is selected.

Green On 100 Mbit/sec data rate is selected.

Orange On 1000 Mbit/sec data rate is selected.
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Parallel Port
Figure 5-4 shows the location and pinouts for the IEEE 1284 (parallel) 
connector on the NI VXIpc-882. Table 5-6 lists and describes the 
IEEE 1284 connector signals.

Parallel port adapter cables are available from National Instruments, 
part number 777169-01.

Figure 5-4.  Parallel Port Connector Location and Pinout

Parallel Port

1

18

19

36
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Table 5-6.  Parallel Port Connector Signals

Pin

Default Configuration (LPT)

Signal Name Signal Description

1 BUSY Device Busy

2 SLCT Select

3 ACK# Acknowledge

4 FAULT#(ERROR#) Fault

5 PAPEREND Paper End

6 PD0 Data Bit 0

7 PD1 Data Bit 1

8 PD 2 Data Bit 2

9 PD3 Data Bit 3

10 PD4 Data Bit 4

11 PD5 Data Bit 5

12 PD6 Data Bit 6

13 PD7 Data Bit 7

14 INIT# Initialize Printer

15 STROBE# Strobe

16 SLCTIN# Select Input

17 AUTOFD# Auto Line Feed

18 +5V +5 V

19–35 GND Ground

36 NC Not Connected
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Universal Serial Bus
Figure 5-5 shows the location and pinouts for the Universal Serial Bus 
(USB) connectors on the NI VXIpc-882. Table 5-7 lists and describes the 
USB connector signals.

Figure 5-5.  USB Connector Location and Pinout

Table 5-7.  USB Connector Signals

Pin Signal Name Signal Description

1 VCC Cable Power (+5 V)

2 D– USB Data –

3 D+ USB Data +

4 GND Ground

USB
4

1



Chapter 5 I/O Information

NI VXIpc-882 User Manual 5-10 ni.com

SMB TRGIN/OUT and EXTCLK
The TRG connectors are the software-controlled trigger connections for 
routing VXI triggers to or from the VXI backplane. For more information, 
refer to the Front Panel SMB TRGIN/TRGOUT section of Chapter 3, 
Configuration and Default Settings.

Figure 5-6 shows the TRG connector locations on the NI VXIpc-882. 
Table 5-8 lists and describes the trigger connector signals.

Figure 5-6.  SMB Connector Location and Pinout

Table 5-8.  TRIG/CLK Connector Signals

Pin Signal Name Signal Description

1 SIGNALCONDUCTOR Trigger/CLK

2 (Shield) GND Ground

1
2

TRIG IN

1
2

1
2

TRIG OUT

EXT CLK (CLK10)
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GPIB (IEEE 488.2)
Figure 5-7 shows the location and pinouts for the GPIB connector on the 
NI VXIpc-882. Table 5-9 lists and describes the GPIB connector signals.

National Instruments provides a GPIB mating connector, part number 
183285-0R2.

Figure 5-7.  GPIB Connector Location and Pinout

GPIB

14

25 13

1
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Table 5-9.  GPIB Connector Signals

Pin Signal Name Signal Description

1 DIO1# Data Bit 1

2 DIO2# Data Bit 2

3 DIO3# Data Bit 3

4 DIO4# Data Bit 4

5 EOI# End or Identify

6 DAV# Data Valid

7 NRFD# Not Ready for Data

8 NDAC# Not Data Accepted

9 IFC# Interface Clear

10 SRQ# Service Request

11 ATN# Attention

12 SHIELD Chassis ground

13 DIO5# Data Bit 5

14 DIO6# Data Bit 6

15 DIO7# Data Bit 7

16 DIO8# Data Bit 8

17 REN# Remote Enable

18–25 GND Logic Ground
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ExpressCard/34 Slot
The NI VXIpc-882 controller is equipped with an ExpressCard/34 slot on 
the front panel, which provides I/O expansion and options for removable 
storage, Ethernet, and a variety of other I/O.

Figure 5-8 shows the location and pinouts for the ExpressCard/34 slot on 
the NI VXIpc-882. Table 5-10 lists and describes the ExpressCard/34 
connector signals.

Figure 5-8.  ExpressCard/34 Slot Location and Pinout

ExpressCard/34
Slot

1

26



Chapter 5 I/O Information

NI VXIpc-882 User Manual 5-14 ni.com

Table 5-10.  ExpressCard/34 Connector Signals

Pin Signal Name Signal Description

1 GND Ground

2 USBD– USB Data –

3 USBD+ USB Data +

4 CPUSB# USB Presence

5 RESERVED Reserved by spec for future use

6 RESERVED Reserved by spec for future use

7 SMBCLK SMBus Clock

8 SMBDATA SMBus Data

9 +1.5V Power

10 +1.5V Power

11 WAKE# PE Wake

12 +3.3VAUX Power

13 PERST# PE Reset

14 +3.3V Power

15 +3.3V Power

16 CLKREQ# Clock Request

17 CPPE# PE Presence

18 REFCLK– Reference Clock –

19 REFCLK+ Reference Clock +

20 GND Ground

21 PERn PE Data Receive –

22 PERp PE Data Receive +

23 GND Ground

24 PETn PE Data Transmit –

25 PETp PE Data Transmit +

26 GND Ground
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Front Panel Features
The NI VXIpc-882 has the following front-panel features:

• A system reset pushbutton (hold the button for at least 2 seconds to 
generate a reset to the controller)

• Eight front-panel LEDs that show PC status:

– FAILED—Indicates the NI VXIpc-882 controller failed power 
on diagnostics.

– SYSFAIL—Indicates the VMEbus SYSFAIL line has been 
asserted on the backplane.

– ONLINE —Indicates the board is detected and ready for use.

– ACCESS indicates the VXI bus master is active.

– CB—Indicates the circuit breaker has tripped from an over current 
condition on the +5.0 VDC rail of the NI VXIpc-882 controller.

– PWR OK—Indicates the on board power supplies are in 
regulation.

– DRIVE—Indicates the hard drive is being accessed.

Data Storage
The NI VXIpc-882 has a SATA hard drive (at least 80 GB).

You can add additional data storage capacity with a USB DVD/CD-ROM 
drive or USB floppy drive. Contact National Instruments to purchase these 
devices.
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6
Common Questions and 
Troubleshooting

This chapter addresses many common questions about the NI VXIpc-882 
controller and includes information for troubleshooting common problems 
you may encounter. If you cannot find the answer to the specific question 
or problem you have, visit the VXI support page at ni.com/support.

General Questions
How do I check the configuration of the memory, hard drive, time/date, 
and so on?

You can view these parameters in the BIOS setup. To enter the BIOS setup, 
reboot the NI VXIpc-882 and press <Delete> during the memory tests. 
Refer to the BIOS Configuration section of Chapter 3, Configuration and 
Default Settings, for more information.

Operating System, Drivers, and Software
What important files and directories are preinstalled on my hard 
drive?

Your hard drive includes a directory called images in its root that 
contains software and soft copies of manuals for your controller 
peripherals. The directory structure under the images directory is logically 
organized into several levels.

In the images directory itself, you will find a manuals directory, 
an os directory, and directories for each computer peripheral or installed 
driver.

The manuals directory contains quick reference guides, technical 
reference manuals, and National Instruments software manuals, all in 
Adobe Acrobat format. To access any manual, change your directory to 
c:\images\manuals and list the contents of that directory. For copies of 
other National Instruments product manuals, visit ni.com/manuals.
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The rest of the directories correspond to each peripheral in your system. 
Within each of these directories are the drivers for the peripherals. These 
files and directories are copied exactly from the manufacturer distribution 
disks, so the naming conventions vary from peripheral to peripheral. You 
can find copies of these peripheral drivers on the VXI support page at 
ni.com.

Because the naming conventions may not be completely straightforward, 
National Instruments provides a text file named drivers.txt in the 
c:\images directory. The drivers.txt file explains how to install 
support for each peripheral. You may want to print this file for reference 
when you install your peripheral device drivers.

How do I install or reinstall the video driver?

Refer to the Drivers.txt file on the hard drive or recovery CD-ROM.

How do I install or reinstall the Ethernet driver?

Refer to the Drivers.txt file on the hard drive or recovery CD-ROM.

How do I install or reinstall the GPIB driver?

1. The best way to set up GPIB is to set up networking on your controller 
so you can access ni.com to download the latest drivers. You can 
access both drivers by going to the current Drivers and Updates page.

2. After these drivers are installed, go into the Device Manager in 
the System Properties window, delete the PCI Bridge and PCI 
Communication Device entries under Other Devices, and reboot the 
controller.

3. When the controller reboots, it correctly finds and installs the proper 
drivers for the GPIB adapter.

How do I install or reinstall the VXI and VISA drivers?

The best way to install NI-VXI and NI-VISA is to set up networking on 
your controller so you can access ni.com to download the latest drivers 
that support your controller. If you cannot access the network, copies of 
these drivers should be available in the Images directory on your hard 
drive.

After you obtain these drivers, uninstall any old versions of NI-VXI or 
NI-VISA and follow the installation instructions downloaded or included 
with the driver you want to install.
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How do I install software from a DVD/CD?

You have the following options:

• USB DVD/CD-ROM—Windows XP supports USB mass storage 
devices. With most USB DVD/CD-ROM drives, once you plug the 
drive into the USB port, you should be able to access the drive through 
a drive letter.

• Mapped network drive—You can use the Ethernet to connect to 
another computer. If you share the CD-ROM drive on the other 
computer, you can map the shared CD-ROM drive to a drive letter 
on the NI VXIpc-882.

How do I flash a new BIOS?

Follow the instructions for upgrading your BIOS by executing a search for 
VXI BIOS at ni.com/support.

Where do I get the latest software and peripheral drivers?

You can download the latest drivers from ni.com/support/ 
vxisupp.htm. For instructions on installing the latest peripheral drivers, 
execute a search for VXI Peripherals at ni.com/support.

Boot Options
What devices can I boot from?

The NI VXIpc-882 can boot from the following devices:

• The internal SATA hard drive.

• An external USB mass storage device such as a USB hard drive or 
CD-ROM.

• An external USB floppy drive.

• A network PXE server on the same subnet.

Note There are some limitations when booting from a USB device. Windows does not 
support booting from USB devices. Windows XP can be installed from a USB 
DVD/CD-ROM, but earlier versions of Windows cannot. The NI VXIpc-882 BIOS 
configures the USB devices so they will work in a DOS environment.
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How do I configure the controller to boot from these devices?

There are two methods:

• Enter Setup and select the Boot menu. You will see a list of all 
bootable devices, ordered by device type. You can set the boot order 
using <+> and <–>. Set the order by device type and set the order for 
the devices listed within the device type.

• To boot from a different device without permanently changing the 
boot order, press <F10> during POST. After the BIOS completes the 
POST and just before the controller boots the OS, the Boot menu is 
displayed. You can select the device type you want to boot from.

Hard Drive Recovery
The NI VXIpc-882 controller includes two methods of restoring the 
original factory condition of your hard drive. Hard drive-based recovery 
stores a factory backup on a separate portion of your hard drive allowing 
you to restore your controller without additional media. The NI VXIpc-882 
controller also ships with an OS Recovery CD that allows you to reinstall 
your operating system onto your hard drive through an external 
DVD/CD-ROM. For more information on these tools, refer to the 
documentation on your hard drive in the c:\Images\Recovery directory 
or KnowledgeBase 2ZKC02OK at ni.com/support.

Note Your system hot key is <F4>. To access the hard drive-based recovery tool, press and 
hold <F4> when video first appears during the boot process.

If you need to recover your factory-installed operating system from a 
DVD/CD, you can use the included OS re-installation CD with an external 
DVD/CD-ROM drive such as a USB DVD/CD-ROM drive. Boot the 
controller using the OS re-installation CD to recover the OS. You also may 
need to reinstall other software after using the CD to recover the OS.

Note Recovering the OS erases the contents of your hard disk. Back up any files you want 
to keep.

Installing an OS
The NI VXIpc-882 controller includes a pre-installed OS. In some cases, 
you may want to install a different OS. When doing so, consider the 
following guidelines.
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Installing from a DVD/CD-ROM
The NI VXIpc-882 controller supports the installation of Windows XP 
from a USB DVD/CD-ROM. However, many other operating systems do 
not support installation from a USB DVD/CD-ROM. For example, 
Windows 2000 aborts during the install process because it does not have 
drivers for the DVD/CD-ROM device.

With DOS drivers, you can install Windows 9x operating systems. 
However, only a few USB DVD/CD-ROM drives have DOS drivers.

As an alternative to a USB DVD/CD-ROM drive, you can use an external 
SCSI DVD/CD-ROM with a VXI-SCSI adapter.

Note For additional assistance with installing or changing an operating system, refer to 
KnowledgeBase 2ZKC02OK at ni.com/support.

ExpressCard/34
This section provides information on the installation and removal of 
ExpressCard/34 modules.

Installing an ExpressCard/34
You can install an ExpressCard/34 module while the NI VXIpc-882 is 
running. The NI VXIpc-882 will automatically detect the card. 
ExpressCard/34s are generally marked with a symbol or a label to indicate 
which end to insert into the slot. The cards are keyed to prevent incorrect 
insertion.

To install an ExpressCard/34, complete the following steps.

1. Hold the card so the top side is facing left.

2. Insert the card until it is completely seated in its connector. The 
connector has an automatic eject mechanism. If you insert the card and 
it is ejected, simply re-insert the card until it is seated.

If you encounter too much resistance, do not force the card. Check the card 
orientation and try again.

The NI VXIpc-882 will automatically recognize the ExpressCard/34 and 
load the appropriate driver(s). Third-party cards may require that you 
install additional drivers. Contact your ExpressCard/34 vendor for more 
information.
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Caution The ExpressCard/34 interface is ESD sensitive. An electrostatic shock on the 
ExpressCard/34 module while it is inserted may cause the controller to lock-up or reboot.

Removing an ExpressCard/34
To remove the ExpressCard/34 module push in the module and then release 
to eject the card. Slide the card out of the slot.

Caution To avoid data loss and other potential issues, stop communication with your 
ExpressCard/34 device before removing it from the NI VXIpc-882. In Windows, use the 
Safely Remove Hardware tool to safely stop the ExpressCard/34.

Cables, Optional Hardware, and Main Power Fuse
How do I connect a standard 25-pin LPT cable to the NI VXIpc-882?

The NI VXIpc-882 uses a type C LPT connector. Most parallel port devices 
use a type A connector. To use a device with a standard type A LPT 
connector, you need to use a type C-to-type A LPT adapter. To order 
the adapter, refer to the online catalog at ni.com.

My NI VXIpc-882 does not have an internal floppy drive. Is there a way 
to use an external drive?

Yes. The NI VXIpc-882 controller supports and can boot from USB floppy 
drives.

The LPT port on the NI VXIpc-882 can also be configured through the 
BIOS setup for floppy signals instead of LPT signals. Refer to Chapter 5, 
I/O Information, for the floppy drive pinout.

I did not purchase a bootable USB DVD/CD-ROM or USB floppy with 
my NI VXIpc-882 controller. How can I obtain one?

Contact National Instruments to purchase these devices.

How do I upgrade system memory?

You can change the amount of installed RAM on the NI VXIpc-882 by 
upgrading the SO-DIMM. Refer to the Installing and Upgrading RAM 
section of Chapter 2, Installation, or ni.com/support for more 
information about supported SO-DIMMs and installation instructions.
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How do I change the main power fuse?

The NI VXIpc-882 is not equipped with a user-replaceable fuse. If the 
internal fuse blows, contact National Instruments for assistance.

Troubleshooting
What if the NI VXIpc-882 does not boot?

Several problems can cause a controller not to boot. Here are some things 
to look for and possible solutions.

Things to Notice 

• Which LEDs come on? The PWR OK LED should stay lit. The 
DRIVE LED should blink during boot as the disk is accessed. 

• What appears on the display? Does it hang at some particular point 
(BIOS, Operating System, and so on)? If nothing appears on the 
screen, try a different monitor. Does your monitor work with a 
different PC? If it hangs, note the last screen output that you saw for 
reference when consulting National Instruments technical support.

• What has changed about the system? Did you recently move the 
system? Was there electrical storm activity? Did you recently add 
a new module, memory chip, or piece of software?

Things to Try

• Make sure the chassis is plugged in to a working power source. 

• Check any fuses or circuit breakers in the chassis or other power 
supply (possibly a UPS).

• Make sure the controller module is firmly seated in the chassis.

• Remove all other modules from the chassis.

• Remove any nonessential cables or devices.

• Try the controller in a different chassis.

• Try a similar controller in this same chassis.

• Recover the hard drive on the controller. (Refer to the Hard Drive 
Recovery section.)

• Clear the CMOS. (Refer to the Default Software Settings section of 
Chapter 3, Configuration and Default Settings.)
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My controller boots fine until I get to Windows, at which point I cannot 
read the screen. This may include garbled output, white screen, black 
screen, or an out of sync message from the monitor.

This problem usually results from having the video card output set past the 
limits of the monitor. You will need to boot Windows in Safe Mode. To do 
this, reboot the controller. As Windows begins to boot, hold down <F8>. 
You should now be able to reset the video driver to lower settings. Try 
setting the resolution to 640 × 480 and the refresh rate to 60 Hz. After you 
reboot, you can raise these values again, using the test option in Windows. 
These settings are accessible through the Advanced tab of the Display item 
in the Control Panel. Alternately, you can try a different monitor, 
preferably a newer and larger one.

My CMOS is corrupted. How do I set it back to default?

1. Enter the BIOS setup program as described in the BIOS Configuration 
section of Chapter 3, Configuration and Default Settings.

2. Press <F9> to load BIOS defaults.

3. Answer Y (Yes) to the verification prompt.

4. Select Save and Exit Setup.

I can’t change the display on the controller from 640 × 480 to 
800 × 600. What’s wrong?

Be sure the video driver is installed. If it is not, refer to the Drivers.txt 
file on the hard drive or recovery CD-ROM.
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A
Specifications

This appendix lists the electrical, mechanical, and environmental 
specifications of the NI VXIpc-882 embedded computers.

Electrical

Note Power usage depends on peripherals connected to the controller. For example, 
connecting four high power USB devices will draw more current from the +5 V rail than 
just connecting a USB keyboard and mouse.

Physical
Board dimensions................................... Two-slot VXI C-size module

233.35 × 340 × 60.96 mm
(9.187 × 13.386 × 2.4 in.)

Slot requirements ................................... Two system slots

Compatibility ......................................... Fully compatible with VXI-6, 
VXIbus Mainframe Extender 
Specification, Rev. 2.0

MTBF..................................................... Contact NI for MTBF

Weight .................................................... 2.58 kg (5.69 lb)

Voltage (V)

Current (A)

Peak Dynamic

+24 3.1 A ±1.26 A

+12 0.225 A ±0 A

+5 10.6 A ±1.21 A

–2 0.251 A ±0.04 A

–5.2 0.318 A ±0.06 A

–12 0.265 A ±0 A
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Operating Environment
Ambient temperature range ....................5 to 50 °C 

(Tested in accordance with 
IEC-60068-2-1 and 
IEC-60068-2-2.)

Relative humidity range..........................10 to 90%, noncondensing
(Tested in accordance with 
IEC-60068-2-56.)

Altitude ...................................................2,000 m (at 25 °C ambient 
temperature)

Pollution Degree .....................................2

For indoor or enclosed area use only.

Module cooling requirements .................For 18 °C temperature rise, 
2.6 liters/sec airflow, 
0.03 mm H2O pressure across 
module, per VXI-8, Cooling 
Characterization Methodology 
Specification

Caution Clean the NI VXIpc-882 with a soft nonmetallic brush. Make sure that the device 
is completely dry and free from contaminants before returning it to service.

Storage Environment
Ambient temperature range ....................–20 to 70 °C 

(Tested in accordance with 
IEC-60068-2-1 and 
IEC-60068-2-2.)

Relative humidity range..........................5 to 95%, noncondensing
(Tested in accordance with 
IEC-60068-2-56.)
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Shock and Vibration
Operational shock1 ................................. 30 g peak, half-sine, 11 ms pulse 

(Tested in accordance with 
IEC-60068-2-27. Test profile 
developed in accordance with 
MIL-PRF-28800F.)

Random vibration

Operating2 ....................................... 5 to 500 Hz, 0.3 grms 
(with solid-state hard drive)

Nonoperating .................................. 5 to 500 Hz, 2.4 grms

(Tested in accordance with IEC-60068-2-64. Nonoperating test profile 
exceeds the requirements of MIL-PRF-28800F, Class B.)

Note Specifications are subject to change without notice.

Safety
This product meets the requirements of the following standards of safety 
for electrical equipment for measurement, control, and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1, CSA 61010-1

Note For UL and other safety certifications, refer to the product label or the Online 
Product Certification section.

Electromagnetic Compatibility
This product meets the requirements of the following EMC standards for 
electrical equipment for measurement, control, and laboratory use:

• EN 61326 (IEC 61326): Class A emissions; Basic immunity

• EN 55011 (CISPR 11): Group 1, Class A emissions

• AS/NZS CISPR 11: Group 1, Class A emissions

• FCC 47 CFR Part 15B: Class A emissions

• ICES-001: Class A emissions

1   Only valid with an NI VXIpc-882 using a solid-state drive, not with the shipping configuration, which contains a hard disk 
drive.

2   Only valid with an NI VXIpc-882 using a solid-state drive, not with the shipping configuration, which contains a hard disk 
drive.
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Note For the standards applied to assess the EMC of this product, refer to theOnline 
Product Certification section. 

Note For EMC compliance, operate this product according to the documentation.

Note For EMC compliance, operate this device with shielded cables.

CE Compliance
This product meets the essential requirements of applicable European 
Directives as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

Online Product Certification
Refer to the product Declaration of Conformity (DoC) for additional 
regulatory compliance information. To obtain product certifications and the 
DoC for this product, visit ni.com/certification, search by model 
number or product line, and click the appropriate link in the Certification 
column.

Environmental Management
National Instruments is committed to designing and manufacturing 
products in an environmentally responsible manner. NI recognizes that 
eliminating certain hazardous substances from our products is beneficial 
not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the 
Environment Web page at ni.com/environment. This page contains the 
environmental regulations and directives with which NI complies, as well 
as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling 
center. For more information about WEEE recycling centers and National Instruments 
WEEE initiatives, visit ni.com/environment/weee.htm.
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Battery Replacement and Disposal
This device contains a long-life coin cell battery. If you need to replace it, 
use the Return Material Authorization (RMA) process or contact an 
authorized National Instruments service representative.

After replacement, recycle the old battery. For additional information, visit 
ni.com/environment.

Front Panel Layout and Dimensions
Figure A-1 shows the front panel layout and dimensions for the 
NI VXIpc-882. Dimensions are in inches [millimeters].

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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Figure A-1.  NI VXIpc-882 Front Panel Layout and Dimensions
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B
Using The Trigger Ports On The 
NI VXIpc-882

The NI VXIpc-882 allows you to extend the 8 TTL backplane triggers and 
CLK10 between chassis through convenient front panel connectors. Each 
trigger and the CLK are independently configurable as either inputs or 
outputs of the frame. The trigger bus is connected in a daisy chain topology 
and can support up to six (6) devices with a total of 19 m of cables.

Cautions The trigger bus uses the MXI-Express x4 cables, however these are not 
MXI-Express x4 ports. Do not connect the trigger ports to a MXI-Express x4 or 
PCI Express x4 device.

The trigger bus may be able to support more devices and/or greater cable lengths, but these 
configurations have not been validated by National Instruments and are not currently 
supported.

Connecting the Trigger Port Cables
When connecting the cables between two devices on the trigger bus, 
always ensure you connect TRIG/CLK PORT A of one device to 
TRIG/CLK PORT B of the second device, or TRIG/CLK PORT B 
of one device to TRIG/CLK PORT A of the second device, as shown 
in Figure B-1. The front panel LED will blink red if the cables are not 
connected correctly. The LED will be lit steady state green if they are 
connected properly.

Note Trigger bus cables may be removed and inserted while power is on.
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Figure B-1.  NI VXIpc-882 Controller Trigger Cabling

Software Configuration
Triggers are mapped into and out of your NI VXIpc-882 though software 
using the following steps.

1. Open MAX.

2. Find your device under Devices and Interfaces.

3. Right click on your device and select Properties.

4. Click on the Signal Mappings Tab.

5. From each TTL Trigger select Into the Frame, Out of the Frame, 
or None.

6. Click OK and re-run the VXI Resource Manager (Resman) for the 
changes to take effect.

Note Do not map the same trigger out of the frame on more than one device on the trigger 
bus. This will cause the bus to be driven by more than one device. Protection circuitry 
prevents this from causing physical damage, however your setup will not function 
properly.

1 TRIG/CLK PORT A
2 TRIG/CLK PORT B

3 Trigger Cable
4 NI VXIpc-882 Controller in Slot 0e

4

1

2

3
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C
VMEbus Capability Codes

This appendix summarizes the VMEbus capability codes for the 
VXIpc-882 hardware.

VMEbus Capability Codes

Capability Code Description

A32, A24, A16 (master) VMEbus master A32, A24, and A16 addressing

A32, A24, A16 (slave) VMEbus slave A32, A24, and A16 addressing

D32, D16, D08(EO) (master) VMEbus master D32, D16, and D08 data sizes

D32, D16, D08(EO) (slave) VMEbus slave D32, D16, and D08 data sizes

BLT, MBLT (master) VMEbus master block and D64 transfers

BLT, MBLT (slave) VMEbus slave block and D64 transfers

RMW (master) VMEbus master read/modify/write transfers

RMW (slave) VMEbus slave read/modify/write transfers

RETRY (master) VMEbus master retry support

RETRY (slave) VMEbus slave retry support

FSD First slot detector

SCON VMEbus System Controller

PRI, RRS Prioritized or Round Robin Select arbiter

ROR, FAIR Release on Request and FAIR bus requester

IH(7–1) Interrupt handler for levels 7–1

I(7–1) Interrupt requester for levels 7–1

D32, D16, D08(O) (Interrupt Handler) VMEbus D32, D16, D08(O) interrupt handler

D32, D16, D08(O) (Interrupter) VMEbus D32, D16, D08(O) interrupter
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ROAK, RORA Release on Acknowledge or Register Access interrupter

BTO(x) VMEbus bus timer (programmable limit)

Capability Code Description
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D
Technical Support and 
Professional Services

Visit the following sections of the award-winning National Instruments 
Web site at ni.com for technical support and professional services:

• Support—Technical support at ni.com/support includes the 
following resources:

– Self-Help Technical Resources—For answers and solutions, 
visit ni.com/support for software drivers and updates, 
a searchable KnowledgeBase, product manuals, step-by-step 
troubleshooting wizards, thousands of example programs, 
tutorials, application notes, instrument drivers, and so on. 
Registered users also receive access to the NI Discussion Forums 
at ni.com/forums. NI Applications Engineers make sure every 
question submitted online receives an answer.

– Standard Service Program Membership—This program 
entitles members to direct access to NI Applications Engineers 
via phone and email for one-to-one technical support as well as 
exclusive access to on demand training modules via the Services 
Resource Center. NI offers complementary membership for a full 
year after purchase, after which you may renew to continue your 
benefits. 

For information about other technical support options in your 
area, visit ni.com/services, or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.
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• Declaration of Conformity (DoC)—A DoC is our claim of 
compliance with the Council of the European Communities using 
the manufacturer’s declaration of conformity. This system affords 
the user protection for electromagnetic compatibility (EMC) and 
product safety. You can obtain the DoC for your product by visiting 
ni.com/certification.

• Calibration Certificate—If your product supports calibration, 
you can obtain the calibration certificate for your product at 
ni.com/calibration.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

n nano 10–9

µ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

G giga 109

T tera 1012

Symbols

• degrees

Ω ohms

% percent

A

A amperes

AC Alternating Current

ASIC application-specific integrated circuit

B

B bytes

backplane An assembly, typically a printed circuit board, with connectors and signal 
paths that bus the connector pins.
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BIOS Basic Input/Output System. BIOS functions are the fundamental level 
of any PC or compatible computer. BIOS functions embody the basic 
operations needed for successful use of the computer’s hardware resources.

C

C Celsius

cache Small portion of high-speed memory used for temporary storage of 
frequently used data

CMOS Complementary Metal Oxide Semiconductor; a process used in making 
chips

CompactPCI An adaptation of the PCI specification for industrial and/or embedded 
applications that require a more robust mechanical form factor than desktop 
PCI. CompactPCI provides a standard form factor for those applications 
requiring the high performance of PCI as well as the small size and 
ruggedness of a rack-mount system.

D

DC Direct Current

DIMM Dual In-line Memory Module

DMA Direct Memory Access; a method by which data is transferred between 
devices and internal memory without intervention of the central processing 
unit

DRAM Dynamic RAM (Random Access Memory); storage that the computer must 
refresh at frequent intervals

DVI-I Video Graphics Array; the minimum video display standard for all PCs

E

ECP Extended Capabilities Parallel

EDO Extended Data Out

EEPROM Electronically Erasable Programmable Read Only Memory
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embedded controller An intelligent CPU (controller) interface plugged directly into the PXI 
backplane, giving it direct access to the PXI bus. It must have all of its 
required PXI interface capabilities built in.

EMC Electromagnetic Compatibility

EMI electromagnetic interference

EPP Enhanced Parallel Port

expansion ROM An onboard EEPROM that may contain device-specific initialization and 
system boot functionality

F

FCC Federal Communications Commission

G

g 1. grams
2. A measure of acceleration equal to 9.8 m/s2

GPIB General Purpose Interface Bus (IEEE 488)

grms A measure of random vibration. The root mean square of acceleration 
levels in a random vibration test profile.

H

Hz hertz; cycles per second

I

I/O input/output; the techniques, media, and devices used to achieve 
communication between machines and users

IDE Integrated Drive Electronics; hard disk and built-in controller

IEEE Institute of Electrical and Electronics Engineers

in. inches
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instrument driver A set of routines designed to control a specific instrument or family of 
instruments, and any necessary related files for LabWindows/CVI or 
LabVIEW

interrupt A means for a device to request service from another device

interrupt level The relative priority at which a device can interrupt

IRQ* Interrupt signal

ISA Industry Standard Architecture; the original PC bus architecture, 
specifically the 16-bit AT bus

K

KB kilobytes of memory

L

LAN Local Area Network; communications network that serves users within 
a confined geographical area. It is made up of servers, workstations, 
a network operating system, and a communications link.

LED light-emitting diode

M

m meters

master A functional part of a PXI device that initiates data transfers on the PXI 
backplane. A transfer can be either a read or a write.

MB megabytes of memory

MTBF Mean time between failure

MTTR Mean time to repair
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N

NI-488 or NI-488.2 The National Instruments software for GPIB systems

NI-DAQ The National Instruments software for data acquisition instruments

NI-VISA The National Instruments implementation of the VISA standard; an 
interface-independent software that provides a unified programming 
interface for VXI, GPIB, and serial instruments

NMI Non-maskable interrupt; high-priority interrupt that cannot be disabled by 
another interrupt. It is used to report malfunctions such as parity, bus and 
math coprocessor errors.

P

PCI Peripheral Component Interconnect. The PCI bus is a high-performance 
32-bit or 64-bit bus with multiplexed address and data lines.

PCMCIA Personal Computer Memory Card International Association

peripheral any hardware device connected to a computer, such as a monitor, keyboard, 
printer, plotter, disk or tape drive, graphics tablet, scanner, mouse, and so on

POSC Power On Self Configuration

PXI PCI eXtensions for Instrumentation; an open implementation of 
CompactPCI that adds electrical features that meet the high-performance 
requirements of instrumentation applications by providing triggering, local 
buses, and system clock capabilities. PXI also offers two-way 
interoperability with CompactPCI products.

R

RAM Random Access Memory; the computer’s primary workspace

RAMDAC Random Access Memory Digital to Analog Converter; the DVI-I controller 
chip that maintains the color palette and converts data from memory into 
analog signals for the monitor

resource hardware settings used by devices in a computer system, including ISA 
interrupt level, DMA channel, and I/O address
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RMS Root mean squared. See also grms.

RTC Real Time Clock; an electronic circuit that maintains the time of day, 
and can also provide timing signals for timesharing operations

S

s seconds

slave A functional part of a PXI device that detects data transfer cycles initiated 
by a PXI bus master and responds to the transfers when the address 
specifies one of the device’s registers

SO-DIMM Small Outline Dual In-line Memory Module

SRAM Static RAM; a memory chip that requires power to hold its content. It does 
not require refresh circuitry as a dynamic RAM chip, but it does take up 
more space and uses more power

ST Start Trigger

Star Trigger Slot This slot is located at Slot 2 in a PXI mainframe and has a dedicated trigger 
line between each peripheral slot. This slot would be used for a module 
with ST functionality that can provide individual triggers to all other 
peripherals.

U

USB Universal Serial Bus

V

V Volts

W

W Watts
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Index

A
ACCESS LED, 5-15
Advanced Setup menu, 3-14
application development, 4-1

configuration, 4-2
debugging, 4-9

NI-Spy (figure), 4-10
VISAIC (figure), 4-10

device interaction, 4-3
NI-VXI

API compatibility layer options, 4-8
API compiler symbols, 4-8
API notes, 4-8

optimizing large VXIbus transfers, 4-7
programming

VXI, 4-5
VXI, example programs (table), 4-7

shared memory, 4-8

B
battery replacement and disposal 

information, A-5
BIOS

checking settings, 6-1
flashing new BIOS, 6-3
setup

Advanced Setup menu, 3-14
Boot Setup menu, 3-18
entering, 3-13
Exiting BIOS Setup menu, 3-18
Integrated Peripherals menu, 3-15
Main Setup menu, 3-14

boot options
Boot Setup menu, 3-18
configuring controller, 6-4
devices, 6-3

C
cabling triggers between two controllers 

(figure), B-2
calibration certificate (NI resources), D-2
CB LED, 5-15
CE compliance, specifications, A-4
CLK10 routing, VXI bus, 3-8

front panel SMB direction, 3-9
W2 jumper, 3-9

optional settings, 3-11
inverting CLK10, 3-11
inverting CLK10 (figure), 3-12
termination, 3-12

selecting
external source

W3 jumper, 3-9
W3 jumper (figure), 3-10

source, 3-9
W4 jumper, 3-10
W4 jumper (figure), 3-10

signal
inverting (figure), 3-12

TRIG/CLK port A/B direction, 3-11
W7 jumper, 3-11

figure, 3-11
CMOS

clearing contents (figure), 3-20
setting back to default, 6-8

COM1 connector
connector signals (table), 5-4
LED states (table), 5-6

common configuration questions
boot options, 6-3
cables, optional hardware, and main 

power fuse, 6-6
general questions, 6-1
hard drive recovery, 6-4
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component side cover, removing, 2-4
configuration, 4-2

BIOS configuration, 3-13
common questions

boot options, 6-3
cables, optional hardware, and main 

power fuse, 6-6
general questions, 6-1
hard drive recovery, 6-4

installing an OS, 6-4
Measurement & Automation Explorer 

(MAX), 3-20
default settings, 3-21
Device tab settings (table), 3-22
General tab settings (table), 3-21
PCI tab settings (table), 3-23
PCI-MXI-2

Device tab settings (table), 3-25
General tab settings (table), 3-25
MXI-2 Bus tab settings 

(table), 3-26
PCI tab settings (table), 3-26
Shared Memory tab settings 

(table), 3-25
Shared Memory tab settings

(table), 3-22
SMB tab settings (table), 3-23
VXI Bus tab settings (table), 3-22
VXI-MXI-2

Device tab settings (table), 3-23
General tab settings (table), 3-23
MXI-2 tab settings (table), 3-24
VXI Bus tab settings

(table), 3-24
MITE EEPROM, 3-6
NI VXIpc-882

shipping configuration settings 
figure, 3-2

trigger ports, B-1
slot 0 detection, 3-5

figure, 3-6

connectors
COM1 connector and signals, 5-4
DVI-I connector and signals, 5-2
Ethernet connector and signals, 5-5
ExpressCard/34 connector and

signals, 5-12
GPIB connector and signals, 5-11
parallel port connector and signals, 5-7
peripheral expansion overview

(table), 5-1
SMB TRGIN/OUT and EXTCLK, 5-9
Universal Serial Bus (USB) connector 

and signals, 5-9

D
data storage, 5-15
DDR2 SO-DIMMs

from National Instruments (note), 2-4
debugging, 4-9

NI-Spy (figure), 4-10
VISAIC (figure), 4-10

Declaration of Conformity (NI resources), D-2
default settings

hardware, 3-1
software, 3-3

developing your application, 4-1
device interaction

application development, 4-3
device tab default settings (table), 3-3
diagnostic tools (NI resources), D-1
documentation

conventions used in the manual, ix
how to use this documentation set, ix
NI resources, D-1
related documentation, x

DRIVE LED, 5-15
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drivers, 6-1
installation

GPIB (IEEE 488.2), 6-2
video, 6-2
VXI, VISA, 6-2

NI resources, D-1
obtaining latest drivers, 6-3

DVD/CD-ROM drive
installing software from, 6-3

DVI-I (video), 5-2
connector signals (table), 5-2
location and pinout (figure), 5-2
overview (table), 5-1

E
EEPROM

configuration, 3-7
figure, 3-7

fixing an invalid configuration, 3-7
electrical specifications, A-1
electromagnetic compatibility, 

specifications, A-3
electrostatic discharge, 2-1
environmental management, A-4
environmental management, specifications

battery replacement and disposal, A-5
Ethernet connector

connector signals (table), 5-5
location and pinout (figure), 5-5

examples (NI resources), D-1
Exiting BIOS Setup menu, 3-18
ExpressCard/34, 2-7, 5-12, 6-5

connector location and pinout
(figure), 5-13

connector signals (table), 5-14
function, 1-3
installing a module, 2-7, 6-5
removing a module, 2-7, 6-6

external clock SMB
function, 1-3
location and pinout, 5-9

F
FAILED LED, 5-15
flashing a new BIOS, 6-3
floppy drive, using external floppy drive, 6-6
front panel

connectors, 5-1
features, 5-15
layout and dimensions, A-5

figure, A-6
SMB ExtClk, 3-27
SMB TRGIN/TRGOUT, 3-27

functional description of NI VXIpc-882, 1-2

G
Gigabit Ethernet, function, 1-2
GPIB (IEEE 488.2), 5-11

connector location and pinout (figure), 
5-11

connector signals (table), 5-11
driver installation, 6-2
function, 1-3

H
hard drive, installing and removing, 2-6
hardware

default settings, 3-1
NI VXIpc-882 trigger port settings, B-1

help, technical support, D-1

I
IEEE 488.2, 5-11
images directory, 6-1
installation, 2-1
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See also configuration
hard drive, 2-6
NI VXIpc-882 installed in a VXI chassis 

(figure), 2-3
RAM, 2-4
removing NI VXIpc-882 from VXI 

chassis, 2-3
installing an ExpressCard/34 module, 2-7
instrument drivers (NI resources), D-1
Integrated Peripherals menu, 3-15
inverting the CLK10 signal (figure), 3-12

K
KnowledgeBase, D-1

L
LabVIEW, 1-4
LEDs, front panel LEDs, 5-15
LPT cable, connecting to NI VXIpc-882, 6-6

M
main power fuse, replacing, 6-7
Main Setup menu, 3-14
manuals directory, 6-1
mating connector

GPIB (IEEE 488.2), 5-11
parallel port, 5-7

Measurement & Automation Explorer 
(MAX), 3-20

default settings, 3-21
Device tab default settings (table), 3-3
Device tab settings (table), 3-22
General tab settings (table), 3-21
PCI tab default settings (table), 3-4
PCI tab settings (table), 3-23
PCI-MXI-2, 3-25

Device Bus tab settings (table), 3-25
General Bus tab settings (table), 3-25

MXI-2 Bus tab settings (table), 3-26
PCI Bus tab settings (table), 3-26
Shared Memory Bus tab settings 

(table), 3-25
shared memory tab default settings 

(table), 3-4
Shared Memory tab settings (table), 3-22
SMB tab default settings (table), 3-5
SMB tab settings (table), 3-23
VXI bus tab default settings (table), 3-4
VXI Bus tab settings (table), 3-22
VXI-MXI-2, 3-23

Device tab settings (table), 3-23
General tab settings (table), 3-23
MXI-2 tab settings (table), 3-24
VXI Bus tab settings (table), 3-24

memory, shared, 4-8
MITE EEPROM

See also EEPROM
configuration, 3-6
power on self configuration, 3-7

figure, 3-7
user/factory configuration, 3-6

N
National Instruments

software, 1-3
support and services, D-1

NI VXIpc-882
BIOS configuration, 3-13
connectors, 5-1

COM1 connector and signals, 5-4
DVI-I connector and signals, 5-2
Ethernet connector

location and signals, 5-5
ExpressCard/34 connector and 

signals, 5-12
GPIB (IEEE 488.2) connector and 

signals, 5-11
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parallel port connector and 
signals, 5-7

SMB TRGIN/OUT and 
EXTCLK, 5-9

Universal Serial Bus (USB) 
connector and signals, 5-9

data storage, 5-15
default software settings, 3-3
description, 1-1
front panel

features, 5-15
system reset pushbutton, 5-15

functional
block diagram, 1-2

(figure), 1-2
description, 1-2

hardware
default settings (table), 3-3

installing
in a VXI chassis, 2-1

figure, 2-3
SO-DIMMs (figure), 2-5

modules, 1-1
overview, 1-1
peripheral expansion overview

(table), 5-1
removing from a VXI chassis, 2-3
shipping configuration settings

(figure), 3-2
software, 1-3
specifications, A-1
trigger ports, B-1
upgrading RAM, 6-6
using external floppy drive, 6-6
VXI trigger lines, 3-27

NI-VISA
definition, 4-1
example programs (table), 4-7
overview, 1-3

NI-VXI
API notes, 4-8

compatibility layer options, 4-8
compiler symbols, 4-8

definition, 1-3, 4-1
example programs (table), 4-7

O
obtaining the latest drivers, 6-3
ONLINE LED, 5-15
online product certification, A-4
operating environment specifications, A-2
optimizing large VXIbus transfers, 4-7
OS installation, 6-4

directory, 6-1
from DVD/CD-ROM, 6-5
overview, 6-1

P
parallel port, 5-7

connector location and pinout
(figure), 5-7

connector signals (table), 5-8
PCI tab default settings (table), 3-4
peripheral expansion overview (table), 5-1
physical specifications, A-1
power-on self-configuration (POSC), 3-7

figure, 3-7
programming VXI, 4-5
programming examples (NI resources), D-1
PWR OK LED, 5-15

R
RAM

DDR2 SO-DIMMs from National 
Instruments (note), 2-4

installing and upgrading, 2-4
upgrading, 6-6
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recycling the battery, A-5
removing

component side cover, 2-4
ExpressCard/34 module, 2-7
hard drive, 2-6

replacing the main power fuse, 6-7
running Resman in MAX (figure), 4-3

S
safety specifications, A-3
selecting

CLK10 source (figure), 3-10
controller in VISAIC (figure), 4-4

Serial (COM1), 5-4
See also COM1 connector
locations and pinout (figure), 5-4

shared memory, 4-8
default settings (table), 3-4

shock and vibration specifications, A-3
slot 0 detection

configuration, 3-5
J2 jumper (figure), 3-6

SMB tab default settings (table), 3-5
SMB TRGIN/OUT, 5-9
SO-DIMM

function, 1-2
installing, 6-6

figure, 2-5
software, 6-1

See also drivers
configuration, 3-20
installing from CD-ROM, 6-3
LabVIEW, 1-4
National Instruments software, 1-3
NI resources, D-1
NI-VISA, 1-3
NI-VXI, 1-3

specifications
CE compliance, A-4
electrical, A-1

electromagnetic compatibility, A-3
environmental management, A-4

battery replacement and 
disposal, A-5

front panel layout and dimensions 
(figure), A-6

online product certification, A-4
operating environment, A-2
physical, A-1
safety, A-3
shock and vibration, A-3
storage environment, A-2
WEEE, A-4

storage environment specifications, A-2
Super I/O, function, 1-3
Support, D-1
support, technical, D-1
SYSFAIL LED, 5-15
system

CMOS, 3-19
controller/non-system controller, 2-1
reset pushbutton, 5-15

T
technical support, D-1
termination resistance for CLK10, 3-12
training and certification (NI resources), D-1
trigger ports

cabling, B-1
figure, B-2

connector
location and pinout (figure), 5-10
signals (table), 5-10

software configuration, B-2
troubleshooting, 6-7

CMOS reset, 6-8
controller does not boot, 6-7
NI resources, D-1
video display, 6-8
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U
Universal Serial Bus (USB), 5-9

connector location and pinout
(figure), 5-9

connector signals (table), 5-9
overview (table), 5-1

upgrading RAM, 2-4
user-configurable settings, 3-5
using the NI VXIpc-882 trigger ports, B-1

V
video

See also DVI-I
changing resolution, 6-8
driver installation, 6-2

viIn access in VISAIC (figure), 4-5
VMEbus capability codes

list (table), C-1
VXI

default settings (table), 3-4
interface, function, 1-3
programming, 4-5
trigger in/out SMBs, function, 1-3
trigger lines, 3-27

VXIbus
CLK10 routing, 3-8

front panel SMB direction, 3-9
W2 jumper, 3-9

optional settings, 3-11
inverting CLK10, 3-11

figure, 3-12
termination, 3-12

selecting external source
W3 jumper, 3-9

selecting source, 3-9
W4 jumper, 3-10

figure, 3-10
TRIG/CLK port A/B direction, 3-11

W7 jumper, 3-11
transfers, optimizing, 4-7

W
watchdog timer function, 1-2
Web resources, D-1
WEEE notification, A-4
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